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Background

In January, 2015, the Mineral County Clerk’s Office notified the Mineral County District 
Attorney of concerns with voting irregularities arising from the conduct of the 2014 
Mineral County General Election. This report summarizes information gathered as a 
result of that initial report and is derived from this office’s investigation, reports and 
assistance from the Nevada Secretary of State, and assistance from the Nevada 
Division of Investigations. This report is made pursuant to Nevada Revised Statutes 
293.755(3) which provides that the district attorney is responsible for violations related 
to tampering or interfering with voting systems. Consequently, the scope of this report 
and its conclusions are limited to those topics and related issues.

Facts

According to information derived from this Office’s investigation, the Mineral County 
general election vote and tabulation of the vote occurred as follows:

During the 2014 General Election, early voting in Mineral County took place between 
October 18 and October 31. During that time, approximately seven hundred and one 
voters cast ballots on one of four electronic voting machines located in the Mineral 
County Clerk’s Office lobby area. 

For the vote, Mineral County used AVC Edge electronic voting machines which are 
provided by Dominion Voting and certified by the Nevada Secretary of State’s Office. 
Each voting machine consisted of a touch-sensitive digital screen, a case containing the 
processor and related hardware, a printer with a storage space for the printed paper 
trail, a cartridge writer, and a cartridge. During voting, the official ballots are saved to a 
cartridge contained within the cartridge writer. Prior to being used in voting, each voting 
machine was assigned a unique identifying number as was each cartridge. While voting 
took place, each machine underwent a daily audit which included, but was not limited to, 
an inspection to ensure that the machine was correctly working and that seals placed on 
the machine and on the cartridges were not subject to tampering.

Following early voting, cartridges were removed by Mineral County Clerk’s Office 
deputies and placed in a sealed bag within the Clerk’s Office vault. On November 4, 
2014, Mineral County conducted its general election. Other than two voting machines 
failing to work properly at the polls, a problem that was quickly remedied by poll 
workers, voting took place without any apparent problems. 

On the evening of election day, the Mineral County Clerk, Cherrie George, and her 
deputy clerk, Terri Farley, began the process of counting early votes. To do so, the 
Clerk’s Office used a laptop computer outfitted with a voting cartridge reader and 
tabulation and reporting software. The software, WinEDS is designed to download and 
tabulate the voting data saved to the cartridge by each Edge electronic voting machine. 
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Generally, results are downloaded from cartridges or read off of absentee ballots. After 
each type of ballots have been tabulated, the software saves results in PDF form, which 
is then saved to a USB storage drive, transferred to a different, network-attached 
computer, and uploaded to a Secretary of State’s Office server. Results are not provided 
to the public until County staff receives that direction from the State office. Throughout 
election day and the tabulation of votes, Dominion Voting contracted to provide an 
onsite technician to assist with any potential technical problems that may arise.

The tally of the vote began on the evening of November 4, 2014, according to protocols 
adopted by Dominion Voting Systems and the Clerk-Treasurer’s Office. Clerk George 
ran a “zero proof summary report” which showed no votes residing in the system from 
previous use. George and election workers signed the report at the time to verify the 
election began with all candidates having received zero votes. George included a copy 
of this report with the materials presented to the Board of County Commissioners 
following the election.

After running the zero proof summary report, Clerk George initiated the software’s tally 
sequence at 6:44 p.m. to tabulate early vote cartridges.  At 6:46 p.m., Clerk George 
attempted to tally cartridge number 32735. According to software logs, this cartridge 
was read in a Manual Entry Mode. The number of ballots counted was zero.

Either prior to the tabulation of this cartridge, 32735, or immediately following tabulation 
of the cartridge, the system experienced an error and had to be restarted. At 6:55 p.m., 
Clerk George tallied cartridge number 32753, which contained 193 ballots. At 6:56 p.m., 
Clerk George tallied cartridge number 32733, which contained 178 ballots. At 6:58 p.m., 
cartridge 32734 was tallied with another 154 ballots. These three cartridges, 32753, 
32733, and 32734, were read in proper tally mode, their votes were recorded by the 
WinEDS software, and these votes comprise the total votes tallied for Mineral County’s 
early vote.1

Following the tally of early voting cartridges, Clerk George and her staff tallied the votes 
from cartridges recording ballots cast on election day. Between approximately 7:15 p.m. 
and 8:55 p.m., the remaining sixteen cartridges were tallied as they were delivered to 
the Clerk’s office from two polling locations within Mineral County.

Following the Secretary of State’s confirmation that polling places had closed and 
results had been received, Clerk’s Office staff posted reports from the cartridge tallies to 
the Courthouse doors. All voting reports, including the erroneous tally of early vote 
cartridge 32735 were provided to the Nevada Secretary of State and, when confirmed 
for posting, were made available to the public.

In the days following the election, Clerk’s Office personnel conducted sample audits of 
the voter-verified paper audit trail. The “VVPAT” consists of the rolls of printed paper 
created by each Edge voting machine as paper-based backup records. It is important to 

 The vote reports from Mineral County Early Voting is attached as Exhibit “A”1
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note that the VVPAT is not the official ballot. The electronic voting machines store the 
official ballot as electronic information on the data cartridge. During the VVPAT audit, 
Clerk’s office staff unrolled random VVPAT paper roll and manually tally votes. Staff 
compiled their results in a separate report which is also conveyed to the Secretary of 
State.

On or before the sixth working day following the election, the Board of Commissioners 
must canvass the election returns. The purpose of the canvass is two-fold: the 
commissioners are to review the abstract results for errors and then declare the official 
results of the election. Following the Board’s acceptance, the clerk certifies that the 
record is a true and correct statement of the votes cast in the preceding election.

Mineral County’s Board of Commissioners met to canvass the general election vote on 
November 12, 2015.  Senior Deputy Clerk Brenda Jones presented the Board with an 2

Abstract of the Vote which contained the Clerk’s Statement of the Vote.  During the 3

canvass of the votes, Commissioner MacBeth noted excessive ballots having been 
requested for mail-in ballots.  However, the Clerk and Board failed to note that early 4

vote cartridge 32735 had registered zero ballots cast nor did they inquire as to why. The 
Board moved forward with the canvass, voting to accept the Clerk’s Statement of the 
Votes and declare them the official results of the Mineral County November 2014 
election.

On November 18, 2014, fourteen days following election day, Nevada Secretary of 
State Office staff discovered a discrepancy in the Mineral County turnout figures. Staff 
discovered that the report of registered voters having voted in Mineral County differed 
from the number of ballots cast in the official results. These staff then contacted Mineral 
County Clerk’s employees. Senior Deputy Clerk Jones provided the Secretary of State’s 
Office with figures from reports run by Clerk’s Office staff.

Once notified of the potential discrepancy, Clerk George contacted the Secretary of 
State’s Office and worked with Dominion Voting to identify the cause of the Mineral 
County problem. George set up one of the Edge voting machines and the WinEDS 
software on the laptop. A cartridge was read by the WinEDS software and the results 
forwarded to Dominion for analysis. By the time Clerk George left office in January, 
Dominion had not reached a definitive explanation of the cause of the error.

After taking office January 5, 2015, newly-elected Clerk Lorraine Haight found materials 
from the November general election in the Clerk’s Office. She found two VVPAT paper 
rolls in a file drawer. On each roll, someone had written 32735, and numbered each roll 
1/2 and 2/2. Haight also found numerous cartridges in a different drawer, and the 

 Notice of the Board’s Meeting is Attached as Exhibit “B”2

 The Board’s Abstract of the Vote and Canvass are attached as Exhibit “C”3

 Meeting Minutes from November 12, 2014, are attached as Exhibit “D”4
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remaining cartridges and VVPAT rolls in a box within the office. Clerk Haight had not 
been made aware by outgoing Clerk George of any issues related to the November 
election. Accordingly, when discovered in her office, Clerk Haight left the materials 
where she had found them.

On January 6, 2015, Clerk Haight received a phone call from elections staff at the 
Secretary of State’s Office. Justus Wendland, HAVA Administrator, asked Haight 
whether she was in possession of any notes or memoranda left by former Clerk George 
regarding the canvass of the votes. Clerk Haight informed Wendland that she was 
unaware of any but would look into whether any documentation had been left by former 
Clerk George. After Clerk Haight and her staff did not find anything, they attempted to 
contact Clerk George regarding the discrepancy and any documentation in the file as to 
the error. Ms. George did not immediately return their calls. Rather, she contacted 
Wendland and told him that she had not documented the errors in the election because, 
in her opinion, the cause of the errors were as of yet undetermined.

Clerk Haight and her staff contacted District Attorney Sean Rowe just before close of 
business on January 20, 2015. They informed Rowe that although they had been under 
the impression from Clerk George that there were potentially four ballots or votes which 
they were unable to track, that according to information they just received, the number 
appeared to be closer to one hundred and seventy missing ballots. The following 
morning, District Attorney Rowe and staff from the Clerk’s Office identified the source of 
the number disparities. Using the information entered into the county’s AS400 database, 
Clerk’s Office staff printed a report of registered voters who cast their ballots during the 
early voting period in October of 2014. Seven hundred and one (701) persons cast 
ballots during early voting. This number contrasted with the number that Clerk George 
had reported in her summary report of five hundred twenty-five. Rowe and Clerk’s staff 
identified that the cartridge numbered 32735 had not registered any votes on the 
summary report, yet printed two VVPAT rolls.

Following direction from the District Attorney and NRS 293.391, Clerk’s staff gathered 
the materials related to the 2014 general election, namely voting machine cartridges, 
VVPAT paper trails, and absentee ballots, and sealed them within the Clerk’s Office 
vault. Staff also stored unused ballots, tally lists, and similar materials in the vault.

Pursuant to NRS 293.755(3), the District Attorney’s Office opened a case to determine 
whether a violation of NRS 293.755 had occurred.5

CONCLUSION

NRS 293.755 prohibits certain acts relative to the electronic voting process and 
machines:

 A copy of the District Attorney’s Office Investigation Report is attached as Exhibit “E”5
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      1.  A person who tampers or interferes with, or attempts to tamper or interfere with, 
a mechanical voting system, mechanical voting device or any computer program used 
to count ballots with the intent to prevent the proper operation of that device, system or 
program is guilty of a category D felony and shall be punished as provided in NRS 
193.130.

      2.  A person who tampers or interferes with, or attempts to tamper or interfere with, 
a mechanical voting system, mechanical voting device or any computer program used 
to count ballots with the intent to influence the outcome of an election is guilty of a 
category B felony and shall be punished by imprisonment in the state prison for a 
minimum term of not less than 2 years and a maximum term of not more than 20 years.

Based upon the facts and evidence obtained in compiling the foregoing, there is 
insufficient evidence to show that a person tampered with or interfered with any 
computer program used to count ballots with the intent to prevent the proper operation 
of that device, system, or program. Furthermore, there is insufficient evidence to show 
that a person tampered with or interfered with a computer program used to count ballots 
with the intent to influence the outcome of an election.

In considering whether to file charges, a district attorney “should file only those charges 
which he reasonably believes can be sustained by admissible evidence at trial.” NDAA 
Prosecution Standards, 2d. Ed., 130 (1991). To sustain convictions at trial, the 
prosecution must provide evidence that proves beyond a reasonable doubt the 
confluence of a criminal act with a criminal intent.

A violation of NRS 293.755 Section (1), requires the following:
• A person
• Tampers or interferes with (or attempts to tamper or interfere with)
• a computer program used to count ballots
• with the intent to prevent the proper operation of that device.

In the present situation, Clerk George clearly operated the computer program 
conducting the tally of the vote. A case for violation of this section also requires 
evidence of “tampering” or “interfering” as well as evidence of an “intent to prevent the 
proper operation of that device.” 

The verb form of tamper possesses two similar definitions: 1. to “interfere with 
(something) in order to cause damage or make unauthorized alterations: someone 
tampered with the brakes on my car.” and, 2, to “exert a secret or corrupt influence upon 
(someone).” New Oxford American Dictionary (2013). To “interfere” means to “prevent (a 
process or activity) from continuing or being carried out properly” or to “handle or adjust 
(something) without permission, especially so as to cause damage”. Id. Because the 
verb “tamper” references the verb “interfere”, this analysis will rely upon the definition of 
“interfere” and whether the act committed was one of “preventing a process or activity 
from continuing or being carried out properly.” Accordingly, the relevant criminal act is 
conduct which prevents the proper tally of the votes within the WinEDS software. 
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In this situation, Clerk George’s failure to place the WinEDS software in the proper tally 
mode could be assessed as an act of interference. However, there must be a nexus of 
act and intent to prevent the proper operation of the device for the conduct to be 
criminal in nature. The evidence gathered in this matter evinces no such intent. The 
evidence shows at most unintentional interference with the operation of the software. 
Following the manual entry of cartridge 32735, all other cartridges were properly read. 
The technician from Dominion Voting Systems, Bruce Belton, did not observe any 
irregularities in Clerk George’s conduct which would support an inference that she 
intended to prevent the proper tallying of votes. Further, when contacted by staff from 
the Secretary of State’s Office, Clerk George expressed surprise that there were 
irregularities between the numbers of ballots and voters. While inferences and 
speculation may be drawn from the improper initial mode, the burden rests solely on the 
prosecution to substantiate a claim of criminal intent—that of intentionally preventing the 
proper operation of the voting tally.

Section (2) of NRS 293.755 involves the same conduct, that is, tampering or interfering 
with the WinEDS software which prevents the proper tally of the votes. However, in 
contrast, the violation of section (2) imposes an additional element of proof: an “intent to 
influence the outcome of an election.” Again, there is no evidence to suggest such an 
intent existed. The Clerk’s Office conducted early voting in the lobby of the Clerk’s 
Office. Staff set up four machines which, then, were available to the public on a random, 
first-come, first-served basis. No one deputy, much less the Clerk, was present for the 
entire early vote. Clerk’s staff did not direct voters to any specific machine, nor did they 
know the outcome of the ballots created on any specific machine. Following the early 
voting period, the cartridges containing voter-data were sealed and placed within the 
vault. These were unsealed by the Clerk and staff on election night without 
foreknowledge of their contents, the votes cast on the machine, or their cumulative 
impact on any individual election race. Consequently, there is insufficient evidence to 
pursue the filing of charges on a violation of NRS 293.755(2). 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Exhibit “A”
Early Voting Machine Reports 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Exhibit “B”
Notice of November 12, 2015, Board Meeting  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Board of 
MINERAL COUNTY COMMISSIONERS 

 
JERRIE TIPTON, Chairman Telephone: 775-945-2446 GOVERNING BOARD FOR THE TOWNS OF 
CLIFFORD CICHOWLAZ, Vice Chairman Fax: 775-945-0706 HAWTHORNE, WALKER LAKE, LUNING 
PAUL MACBETH, Member PO Box 1450 AND MINA 
 
CHERRIE GEORGE, Clerk of the Board 

Hawthorne, NV 89415 
mincommissioner@mineralcountynv.org  

LIQUOR BOARD AND GAMING BOARD 
COUNTY HIGHWAY COMMISSION 

 
November 6, 2014 

 
NOTICE OF RECESSED MEETING 

 
Agenda for the Meeting of the Board of Mineral County Commissioners, the Town Governing Boards 
for the Towns of Hawthorne, Luning, Mina and Walker Lake, County Liquor Board, County Gaming 
Board, County Highway Commission, County Health Board, County Licensing Board and the Licensing 
and Control Board for Houses of Prostitution. 
 
PLACE OF RECESSED MEETING:County Commissioner’s Meeting Room, Mineral County 
Courthouse, First and “A” Street, Hawthorne, Nevada.  
 
DATE AND TIME OF RECESSED MEETING: Wednesday, November 12, 2014, commencing at 9:00 
AM. If a mid-day recess is necessary the meeting will reconvene at 1:30 PM. 
 
NOTIFICATIONS: (1) Unless otherwise stated or scheduled for a specific time, items may be taken out 
of the order listed. (2) The Board may combine any two or more items for consideration and/or action. 
(3) The Board may remove any item or delay discussion relating to any item at any time. (4) The Board 
may take action on any item scheduled for review or consideration immediately following such review or 
consideration. (5) Comments from the public will be limited to three (3) minutes per person. 

 

 
  Page 1 of 3 

1. Pledge of Allegiance and Safety Message 
  

2. Minutes of November 5, 2014 – For review and possible action.  (Public comment following.)  
  

3. Business License Applications – The following applications will be presented for discussion 
and possible action with public comment following each application: 
 
A. Golden Gate SET Retail of NV LLC; Port of Subs #171; 705 Highway 362, Hawthorne, NV; 

New Applicants 
 
B. Clay P. Davis; East Fork Roofing; Countywide; Applicant - Prior License Holder Expired  

  
4. Honorable Stewart Handte, Sheriff – For consideration and possible action regarding approval 

of the 2014 STOP/SASP Violence Against Women Grant, funding period of January 1, 2015 – 
December 31, 2015. (Public comment following.) 

  
5. Mike Trujillo, Public Works – For consideration and possible action relative to Capital Outlay 

Purchase of a service truck for the Road Department. (Public comment following.) 
  

6. Larry Grant, Airport Land Advisory Board – For consideration and possible action relative to 
approval of airport lease agreement with Flyers Energy LLC. (Public comment following.) 

  
7. Honorable Beth Cichowlaz, Public Administrator – For consideration and possible action 

relative to request for office space and storage space at Tri County Building. (Public comment 
following.) 
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November 6, 2014 
NOTICE OF RECESSED MEETING 

 
Agenda for the Meeting of the Board of Mineral County Commissioners, the Town Governing Boards for the 
Towns of Hawthorne, Luning, Mina and Walker Lake, County Liquor Board, County Gaming Board, County 
Highway Commission, County Health Board, County Licensing Board and the Licensing and Control Board for 
Houses of Prostitution to be held on Wednesday, November 12, 2014. 
 

 
 
  Page 2 of 3 

8. Jeff Barrow – For consideration and possible action relative to proposed addendum to Southern 
Methodist University’s (SMU) Lease at the Mina Municipal Building, and the mutual 
improvements to plumbing, etc., that might be necessary. (Public comment following.) 

  
9. Teri Knutson – For consideration and possible action relative to BLM program updates. (Public 

comment following.) 
  

10. Honorable Cherrie George, Clerk Treasurer– For consideration and possible action relative to 
the Canvass of the Results of the General Election held on November 4, 2014. (Public comment 
following.) 

  
11. Honorable Board of Mineral County Commissioners – For consideration and possible action 

relative to acceptance of letters of interest from and appointment of members to the Mineral 
County Advisory Commission for Military Affairs. (Public comment following.) 

  
12. For consideration and possible action relative to approval of Victims of Crime Case #14-001. 

(Public comment following.) 
  

13. For consideration and possible action relative to adoption of a resolution providing for the 
transfer of Mineral County’s 2014 Private Activity Bond Cap to the Nevada Rural Housing 
Authority.  (Public comment following.) 

  
14. Closed Session – Pursuant to Nevada Revised Statute (NRS) 241.015(2)(b)(2) to receive 

information from legal counsel relative to existing/pending litigation involving Walker Lake. 
  

15. Open Session – Discussion and possible action relative to existing/pending litigation involving 
Walker Lake and general information relative to Walker Lake. (Public comment following.) 

 
TIME SPECIFIC ITEMS: 
 

9:30 AM Public Hearing – For consideration and possible action relative to adoption of Ordinance 
235A, Bill Number: 251; An Ordinance to Amend Mineral County Code to Establish 
Permit Processes for Renewable Energy Generation Projects. (Public comment 
following.) 

  
10:00 AM Closed Session – Pursuant to NRS 288.220 to discuss/review all labor/bargaining unit 

contracts, grievances and negotiations. 
  

Immediately 
Following 

Open Session – Discussion and possible action relative to all labor/bargaining unit 
contracts, grievances and negotiations. (Public comment following.) 

  
10:30 AM Mina Town Advisory Council - For consideration and possible action relative to Mina 

Town vote on July 25, 2014 to create their own planning/zoning commission, as 
continued from August 20, 2014 meeting of the Board of County Commissioners. (Public 
comment following.) 
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November 6, 2014 
NOTICE OF RECESSED MEETING 

 
Agenda for the Meeting of the Board of Mineral County Commissioners, the Town Governing Boards for the 
Towns of Hawthorne, Luning, Mina and Walker Lake, County Liquor Board, County Gaming Board, County 
Highway Commission, County Health Board, County Licensing Board and the Licensing and Control Board for 
Houses of Prostitution to be held on Wednesday, November 12, 2014. 
 

 
 
  Page 3 of 3 

3:00 PM Accounts Payable Vouchers, Credit Card Approval Form Requests, Capital Outlay 
Purchase Orders and Auditor’s Cash Report by Fund presented for review, 
discussion and possible action. (Public comment following.) 

  
Immediately 
Following 

Treasurer’s Accounting Fund Summary Balance Report and Financial Horizon 
Credit Union Accounts Report – presented for review, discussion and possible action. 
(Public comment following.) 

 
Board of Highway Commissioners 
 
Public Comment 
 
Commissioner Recognition 
 
 
NOTE: Persons attending the meeting who are disabled and require special accommodations or 
assistance are requested to notify the County Clerk’s Office, PO Box 1450, Hawthorne, NV 89415 
or by calling 945-2446 no later than three (3) days prior to the meeting. 
 
Mineral County is an equal opportunity provider and employer. If you wish to file a Civil 
Rights program complaint of discrimination, complete the USDA Program Discrimination 
Complaint Form, found online at http://www.ascr.usda.gov/complaint_filing_cust.html, or at 
any USDA office, or call (866) 632-9992 to request the form. You may also write a letter 
containing all of the information requested in the form. Send your completed complaint 
form or letter to us by mail at U.S. Department of Agriculture, Director, Office of 
Adjudication, 1400 Independence Avenue, S.W., Washington, D.C. 20250-9410, by fax (202) 
690-7442 or email at program.intake@usda.gov. 
 
A COPY OF THE AGENDA WILL BE POSTED AT THE FOLLOWING LOCATIONS: 
x Mineral County Independent-News, 420 3rd Street, Hawthorne, Nevada 
x Mineral County Clerk & Treasurer’s Office, Mineral County Courthouse Hawthorne, Nevada 
x County Commissioner’s Meeting Room, Mineral County Courthouse, Hawthorne, Nevada 
x Lobby of the Mineral County Courthouse, Hawthorne, Nevada 
x Bulletin Board at the Hawthorne Post Office, Hawthorne, Nevada 
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Exhibit “C”
Abstract of the Vote and Canvass  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Exhibit “D”
Meeting Minutes from November 12, 2014 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Mineral County District Attorney’s Office 

May 3, 2015 

Mineral County 2014 General Election Vote 
Investigation Report 
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Overview

Initial Contact 1 ................................................................................................................
1/21/15 Phone Call - Justus Wendland, Nevada Secretary of State’s Office 2 ................
1/23/15 Interview: Deputy Clerk Brenda Jones, Mineral County Clerk’s Office 3 ............
1/23/15 Interview: Deputy Clerk Farley, Mineral County Clerk’s Office 4 .........................
1/24/15 Phone Call - Cherrie George, Former Mineral County Clerk 4 ............................
1/26/15 Phone Call - Scott Gilles, Nevada Secretary of State’s Office 5 .........................
1/26/15 - Phone Conference - Nevada Secretary of State 6 ............................................
2/10/15 Phone Call - Sgt. Dan Johnson, Nevada Division of Investigations 6 .................
2/16/15 Phone Call - Sgt. Johnson 6 ................................................................................
2/16/15 Phone Call - Scott Gilles 6 ..................................................................................
2/18/15 Email - Kevin Benson 6 .......................................................................................
2/18/15 Phone Call - Captain Ryan Miller, Nevada Division of Investigations 7 ..............
2/26/15 - Phone Conference - Nevada Secretary of State and NDI 7 .............................
2/27/15 - Investigative Activity 7 ......................................................................................
3/16/15 Phone Call - Detective Mike Marty, Nevada Division of Investigations 7 ............
3/16/15 Meeting - NDI 7 ...................................................................................................
3/31/15 Email - Justus Wendland 7 .................................................................................
4/14/15 Phone Call - Detective Mike Marty 8 ...................................................................
4/15/15 Email - Justus Wendland 8 .................................................................................
4/17/15 Email - Justus Wendland 8 .................................................................................
4/22/15 Phone Conference - Nevada Secretary of State and NDI 9 ...............................
4/23/15 - Second Interview of Cherrie George. 9 ............................................................
4/23/15 Phone Call - Justus Wendland 10 .......................................................................
4/23/15 Phone Call - Bruce Belton, Contractor for Dominion Voting Services 10............
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Initial Contact

On Tuesday, January 20, 2015, I received a message to contact the Mineral County 
Clerk’s Office (MCCO). At approximately 1645, I called and spoke with Deputy Clerk 
Brenda Jones. Jones informed me that they had been contacted by the Nevada 
Secretary of State’s Office regarding a discrepancy of approximately 170 votes in the 
previous November general election. I proceeded to the MCCO to learn more about the 
issue. 


I went to the Courthouse to meet with Clerk’s Office staff which, at the time, consisted 
of newly-elected Clerk Haight and Deputy Clerks Jones and Farley. Jones informed me 
that the office had been notified that the Supreme Court and Secretary of State had 
flagged the turnout figures from Mineral County’s election. Previously, Clerk Cherrie 
George had communicated with the staff that a total of four votes were potentially in 
question. That afternoon, the staff had been informed that there were questions with at 
least 170 ballots. During this meeting, I was shown two rolls of paper which had been 
found by Clerk Haight in her desk. These rolls were the printed paper receipts from one 
of the voting machines and were labeled 32735 rolls one and two. The number 32735 
corresponded to the number of the machine from which the paper receipts were 
printed. These were placed back into the clerk’s office. 


I then I advised the employees that I would be conducting an inquiry into this matter. I 
further advised them that there was a potential that the issues involved in this inquiry 
could be of a criminal nature, that they were to keep this matter confidential until told 
otherwise. 


I returned to the MCCO the next morning, January 21, 2015, to begin my inquiry into 
the “missing” votes. Jones showed me a copy of Clerk George’s report to the SOS 
which broke down Mineral County’s general election votes into Early, General, 
Absentee, etc. This report showed that 525 ballots were cast during early voting. I 
asked Jones whether Mineral County’s records were able to show how many persons 
came in to the courthouse to cast their votes. Jones said that when a voter comes in to 
cast their ballot, the deputy clerk enters their name into their terminals for the AS400 
server which houses the county’s database. She further explained that it was the total 
voter number from the AS400 which caused the SOS to flag Mineral County’s results. 


I asked Jones whether it was possible to print a report for each category of votes in 
attempt to reconcile with Clerk George’s summary report. Jones was able to print a 
report for the early votes. The AS400 report showed the names of 701 persons who 
cast ballots during early voting. This contrasted with the 525 shown in Clerk George’s 
summary report. This is a difference of 176 ballots. I asked Jones whether there was a 
report showing the number of votes cast on each machine during early voting. Jones 
showed me a report from election night entitled Early Voting Results (Edge Machines), 
General Election, Mineral County, Nevada, November 4, 2014. This report breaks down 
the votes and ballots cast by individual machines. It shows the following turnout 
results: 
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Machine 32733 : 178 

Machine 32734: 154 

Machine 32735 : 0 

Machine 32753 : 193 


Total: 525 


I verified again that the paper vote receipts from the machines found in the Clerk’s desk 
were labeled as being from machine number 32735. At this time, I determined that the 
discrepancy between the AS400 report of turnout and the count from caused by this 
report of zero votes on machine number 32735. 


1/21/15 Phone Call - Justus Wendland, Nevada Secretary of State’s Office

Clerk Haight and I contacted Justus Wendland of the SOS. Wendland had notified 
Jones of the turnout discrepancy the previous day which led to my involvement in this 
matter. I introduced Clerk Haight and myself and informed Wendland that I was calling 
in reference to the Mineral County vote discrepancy. Wendland informed me that he 
had contacted the MCCO earlier to discuss a discrepancy in the Clerk’s submitted 
reports. Wendland said that he had been aware of the discrepancy since late 
November or early December and that he had spoken at length with Clerk George 
about it. He asked what my concern was at this point. I told him that Clerk Haight and I 
were concerned that 176 persons did not have their votes counted, that this undercut 
the validity of Mineral County’s election results, and would negatively impact voter 
confidence in the electoral process in Mineral County. 


Wendland responded that the election results were the official results when canvassed 
by the County Commission and unopposed by the candidates within the timeframes 
available for a contest. He also indicated that in his opinion the cause of the problem 
was a system error in the process of reading the vote cartridge from the voting 
machine. Wendland compared it to a USB memory stick that was not read despite 
having been inserted into a computer. Wendland said that two other counties 
experienced problems related to turnout figures but had caught and corrected it on 
election night. I asked Wendland about the nature of his involvement in the issue of the 
Mineral County General Election. Wendland said that he works for the Nevada SOS as 
the HAVA (Help America Vote Act) Administrator. The purpose of his position is to 
ensure that elections are conducted in accordance with that act. 


Wendland said that in this capacity he receives a number of reports from counties to 
look at voting procedures and uniformity of voting law. With regard to Mineral County, 
Wendland had attempted to reconcile the number of ballots cast with the various 
reports sent to the SOS office. He stated that he discovered that potentially 176 ballots 
had been cast that did not reconcile with the report he obtained from the MCCO for 
numbers of voters signing in at the polls. He said that he recalls having contacted Clerk 
George on or about the date of the State canvass of the votes. The State of Nevada 
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held its canvas of the votes on November 25, 2014. He indicated that Clerk George 
was surprised by his information. He further stated that he worked extensively with 
Clerk George to determine what had happened and how. It was his opinion, as stated 
earlier, that this was an error related to the processing of the vote cartridges. I told 
Wendland that I was concerned with the potential for criminal liability for manipulation 
of a voting machine. He said that he had absolutely no reason to believe that there was 
any criminal wrongdoing on the part of Clerk George. He stated that Clerk George had 
been upset at the information presented to her and had then worked hard to uncover 
the cause of the discrepancy. He also said that Clerk George had, following the 
discovery of the error, reviewed the results and noted that, had the results been 
included in the final vote tallies, that no race outcomes were changed. I thanked 
Wendland for his time and let him know that I would be following up more with him as I 
went through my investigation. 


1/23/15 Interview: Deputy Clerk Brenda Jones, Mineral County Clerk’s Office

On January 23, 2014, I interviewed with MCCO Deputy Clerk Jones. She described her 
involvement in the November 2014 general election as follows. Early voting ended on 
October 31, 2014. She and other deputy clerks sealed up the voting machine 
cartridges into one bag which was placed into the MCCO vault. Those cartridges were 
next handled on election night when they were counted. The procedure was for a 
deputy clerk or election worker to obtain the sealed bag from the vault, and take it to 
Farley who unsealed the bag and handed each cartridge to Clerk George. Clerk George 
inserted the cartridges into the cartridge reader which then, through software operating 
on the computer to which it was attached, tallied the numbers of votes cast. The 
software generated a report which was then placed on a USB memory stick. Clerk 
George removed the USB memory stick and went to her computer to send the reports 
to the SOS. DC Jones did not know what type of file format were used for the reports. 
Jones said that the reports were called "Edge Reports”. Once the SOS received and 
approved posting of these reports, they were taped to the windows of the court house 
for public review. After the posting of the final vote reports, DC Jones said that Clerk 
George sent poll workers and the deputy clerks home. 


Deputy Clerk Jones went on to tell me that in the days following the election, 
Jones, her fellow deputy clerks, and a deputy clerk from the Mineral County Recorder’s 
Office conducted what she referred to as the VPAT audit. This process involves 
the manual audit of the voting machine tape receipts. In this audit, machines are 
randomly selected and the tape receipts fully audited. The Deputy Clerks then tallied 
their results on reports, copies of which were then provided to the SOS. The original 
reports of these audits remain in the MCCO vault.


Following the canvass of the votes by the MCBCC, Jones recalled that Clerk George 
had set up one of the voting machines in the MCCO as well as the card reader and 
computer. She saw Clerk George working on these machines but did not know what 
Clerk George was doing. Clerk George did not inform her staff of what she was doing. 
Jones could not tell me with certainty which day this happened on. 


!  of 113156



1/23/15 Interview: Deputy Clerk Farley, Mineral County Clerk’s Office

I then spoke with Deputy Clerk Terri Farley. Farley has worked for the MCCO since 
May, 2011. Farley indicated that after my meeting with the staff on Tuesday and 
Wednesday, January 20 and 21, she contacted the vendor for the voting systems, 
Dominion. DC Farley spoke with Julie Hoffman who confirmed that she had been made 
aware of a problem with the reporting of votes in Mineral County on the date of the 
State of Nevada canvas. Hoffman denied that any errors in the Mineral County vote 
count was caused by an error of the Dominion Edge systems. 


Farley complained that she felt that she was being “set up” by Clerk George and that 
Julie Hoffman informed her of such when Hoffman was in Mineral County prior to the 
general election for a process called Pre-Lat. Farley said that her involvement on 
election night consisted of, among other things, unsealing the sealed cartridges and 
providing them to Clerk George. Farley confirmed that the cartridges had been sealed 
from early voting. Farley said that from where she was sitting and what she was doing 
that she wasn’t able to see the results from each cartridge as they appeared on the 
reports on the Computer. DC Farley said that Clerk George took the reports from the 
laptop on which they were generated to her computer and that they were emailed to 
the Secretary of State. She stated that she felt that Clerk George had the opportunity at 
that time to manipulate the reports because of Clerk George’s advanced computer 
skills. 


Farley went on to explain that she, as with other elections staff, was sent home 
following final posting of results. Clerk George remained in the office to compile further 
reports from the election. 


Deputy Clerk Farley described an exchange in the weeks following the election. While 
Farley was sitting at her desk, Clerk George brought the box of reports from the 
elections and placed them on Farley’s desk. Clerk George told Farley “I hope they call 
you. Here you go. It’s all on you." She was unable to recall when this exchange took 
place. 


1/24/15 Phone Call - Cherrie George, Former Mineral County Clerk

On Saturday, 24 Jan, I spoke with Clerk George by telephone. She had come to my 
house earlier while I was unavailable and, agitated, asked that I contact her. I called her 
on her personal cell phone. We spoke for approximately 52 minutes. She indicated that 
she was made aware of posts on Facebook that said that there was voter fraud in 
Mineral County and that “the DA knew about it.” Clerk George demanded to know why 
I hadn’t contacted her. I responded that I was conducting an inquiry into what had 
transpired and that I was trying to gather the facts prior to speaking with her. I informed 
her that as the former elections official for Mineral County, she was obviously the 
person against whom the allegations of criminal conduct were being raised and, 
accordingly, that I am interested in the facts that I can establish independent of 
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her viewpoint. I also informed her that, having established those facts, I would like to 
have a longer, more in-depth interview with her. 


I informed Clerk George that I had isolated the source of the problems in the early 
voting machines and asked about what she had determined caused the problem.  


Clerk George told me her side of the story. She said that prior to being notified by 
Justus Wendland that she was unaware of any issues in the November election. After 
being notified, she had attempted to uncover the source of the inaccurate report with 
the voting machine vendors. She had set up a voting machine following Wendland’s 
notification in order to provide the vendor with the raw data from the unread cartridge. 
After providing the vendor with the data, she was informed that the reason the 
cartridge was not read was because it had been assigned, presumedly during 
the preLat process, a duplicate cartridge identity number. Clerk George said that she 
sent an email strenuously objecting to this conclusion, asking for proof that this was 
indeed the case. She has not received this information. 


Clerk George said that she was instructed by the Secretary of State’s office that, 
because the time to contest elections had passed, that there was nothing left for her to 
do in the matter. 


Clerk George was very emotional during this phone call, alternating between being 
indignant/defensive and aggressive towards me. She stated that she has always tried 
to do her job and do it properly. She stated that she was always taught to do the right 
thing, and that in so doing, she would not have to worry about things such as 
this. Clerk George asked what had she done to deserve this treatment? She also asked 
whether she hadn’t earned better treatment by me than being treated like a suspect. 


I concluded my phone conversation by telling Clerk George that I would need to have 
more information from her, that this was an ongoing investigation, and that I would 
speak with her on Monday to arrange a time to speak with her in greater depth. 


1/26/15 Phone Call - Scott Gilles, Nevada Secretary of State’s Office

On Monday morning, 26 Jan, I contacted Scott Gilles, Deputy Secretary of State for 
Elections. I informed him that I was calling in reference to the Mineral County general 
elections incident. Gilles responded by saying that this was the “Human-error” incident 
in Mineral County of which he had been made aware. I confirmed that I was hoping to 
speak with him about the problems with the Mineral County vote. We discussed the 
issue briefly. Gilles confirmed that he had spoke with Justus Wendland about Mineral 
County’s problems. He said that it was his understanding that Clerk George had been 
instructed to document the problem with the vote and inform local officials of what had 
transpired. I told Gilles that there had been no notification by Clerk George to the local 
officials. I further discussed  that I was conducting an inquiry into the problem within 
Mineral County. Gilles indicated that while his information and familiarity with the 
situation was derived from staff, his office would assist my inquiry. Further, I let Gilles 
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know that media had been contacted by the candidates from the election and that 
allegations of voter fraud were being raised. We scheduled a telephone conference call 
with the Secretary of State and other staff later in the afternoon. 


1/26/15 - Phone Conference - Nevada Secretary of State

Later that day, I spoke via conference call with Secretary of State Cegavske, Deputy 
AG Kevin Benson, and Gilles. Because I was already conducting an inquiry into the 
matter, it was discussed that my investigation would proceed and that the Secretary of 
State would provide support.


2/10/15 Phone Call - Sgt. Dan Johnson, Nevada Division of Investigations

On Monday, Feb 10, I contacted Sergeant Dan Johnson from Nevada Division of 
Investigations to request investigative assistance from NDI for computer forensics on 
the computer used to read voting machine cartridges. I Informed Sgt. Johnson that I 
needed to have images made of the hard drives to preserve any information contained 
on the machines. Furthermore, I explained that this computer, and possibly the clerk’s 
main computer, were critical evidence to my investigation into what had occurred in the 
November voting process. Sgt. Johnson asked me to formalize my request on a 
request for assistance form. He provided me, via email, an updated RFA form.This was 
filled out and returned later that day. 


2/16/15 Phone Call - Sgt. Johnson

On Monday, Feb 16, I attempted to contact Sgt. Johnson and was unable to reach him. 
I left him a message to contact me at his earliest convenience. 


2/16/15 Phone Call - Scott Gilles

On Monday, Feb 16, I also attempted to follow-up with Scott Gilles. I was informed that 
Gilles no longer worked with the Secretary of State’s Office. I was able to speak with 
Kevin Benson, Deputy AG for the Secretary of State. I discussed with Benson that I 
had asked NDI for forensic assistance and updated Benson on the progress of my 
inquiry.


2/18/15 Email - Kevin Benson

Wednesday, Feb 18: I Received email from Kevin Benson with a written statement by 
Justus Wendland. Wendland's statement, attached, details his and his office’s 
involvement in the 2014 Mineral County Canvas. Per Wendland’s statement, his office 
discovered the issue with the Mineral County vote following its acceptance and canvas 
by the Mineral County Board of Commissioners. He contacted Clerk George and 
attempted to determine the cause of the issue. Echoing his earlier comments, 
Wendland wrote that he had no indication of any criminal wrongdoing.
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2/18/15 Phone Call - Captain Ryan Miller, Nevada Division of Investigations

I telephoned Captain Miller to set up a conference call with Benson, Wendland, and, 
possibly, Allan Glover on Thursday, 26 Feb. The purpose of the call was to discuss a 
plan of action in regards to my request for assistance to NDI. I then called Benson and 
Wendland to discuss the schedule call.


2/26/15 - Phone Conference - Nevada Secretary of State and NDI

26 Feb - I conducted a telephone conference with Chief Pat Conmay and Captain Ryan 
Miller,  Secretary Cegavske, Justus Wendlend, Kevin Benson, and Allan Glover. Chief 
Conmay recited that his agency had received an RFA from me. He said that he had 
asked to include the Secretary of State in this phone conference based upon that 
Office’s general jurisdiction over elections. Logistics were worked out for NDI, along 
with one or two agents from the Secretary of State’s Office, to retrieve the laptop and 
conduct investigation on it. Chief Conmay committed to sending a detective from NDI 
to Hawthorne to retrieve the laptop computer used to tally votes. NDI would provide 
evidence security and work to obtain forensic assistance from the Washoe Crime Lab. 
The Secretary of State’s Office agreed to work with NDI’s detective to obtain logs from 
the machine that would clarify what occurred in this matter.


2/27/15 - Investigative Activity

Friday, 27 Feb 15 - NDI Detective Mike Marty, Justus Wendland, and Allan Glover from 
the Secretary of State’s Office travelled to Hawthorne to retrieve the elections laptop. 
Detective Marty will be conducting forensics on the laptop and obtaining logs from the 
software located on the machine.


3/16/15 Phone Call - Detective Mike Marty, Nevada Division of Investigations

16 Mar 15 - Spoke by phone with Det Mike Marty. He informed me that the forensics 
on the computer had been completed and his reports done. Detective Marty sent an 
email with unapproved drafts of his reports.


3/16/15 Meeting - NDI

23 Mar 15 - I spoke to Lt. Andy Razer and Sgt Johnson re lack of a final report. 
Reconfirmed with them that I needed this as quickly a possible. I reconfirmed that I 
needed the logs and any explanations of them obtainable by their office.


3/31/15 Email - Justus Wendland

31 Mar 15 - I received an email from J Wendland with Excel copies of WinEDS logs. 
Although I could not open them, I was able to create a work around to be able to read 
the reports. Lines 64 - 47 show the activity relevant to the initial start up of the WinEDS 
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system as well as the early voting cartridges. A copy of the WinEDS logs with activity 
related to the November 4, 2014, is attached.


4/14/15 Phone Call - Detective Mike Marty

14 April 15 - I contacted Det. Marty to set up interviews with Clerk George and 
potentially Deputy Clerk Farley regarding their usage of the WinEDS software on 
election night. He informed me that he would have to discuss this with Captain Miller. 


4/15/15 Email - Justus Wendland

15 April 15 - I received an email forwarded to me by Wendland from Tina Polich and 
Mark McKinney with explanations for log entries. Per Mark McKinney, the relevant log 
entries reveal the following: 


1. This log entry records that someone has completed a manual data entry for 
the early 
vote cartridge 32735. Once entered the data cannot be updated, although the 
cartridge can be removed from tally. If it is removed, the results cartridge from 
the 
machine can be read into tally or a manual data entry can once again be done 
to enter the data into WinEDS.

2. Row 60  - manual data entry was done for Early Vote cartridge 32735.

3. Row 59 through Row 52 –
 Someone has started the tally wizard 4 times. Each time you get two log entri
es; one 
is an update of the Tally_Session record and the other is an update of the Tally 
Profile 
record. The entries only indicate that the Tally Wizard was run. They do not indi
cate 
that any results cartridges were loaded into WinEDS. You would see other log 
entries in that case like those on rows 51 and 50.

Row 51 –
 Early Vote cartridge 32753 was read into WinEDS. That that the actual cartridg
es was uploaded. Manual Data Entry was not done on this cartridge like it was 
for cartridge 32735 on Row 60.

Row 50 –
 The status in the Cartridge_Status table for cartridge 32753 was update from 
11 to 0 ( 'Reading' to 'In Queue').

Rows 49 and 48 are the same entries as above except for cartridge number 32
733.

Rows 47 and 46 are also the same as rows 51 and 50 except that the cartridge
 being read into WinEDS was 32734.


4/17/15 Email - Justus Wendland

I obtained WinEDS manuals from J Wendland. Copies of the manuals are attached.
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Section 12.3.6 details the process to place WinEDS into manual entry mode: 
To place the WinEDS tally into manual mode, the user checks a single 
checkbox button on the source selection as a software “wizard” takes the user through
 a series of questions. Following selecting the manual source, the tally wizard presents 
the user with a tally wizard “review” window which appears the same as the review 
window for tallying votes from the cartridge source.


4/22/15 Phone Conference - Nevada Secretary of State and NDI

22 April 15 - On Wednesday, I conducted a second phone conference with Chief 
Conmay, Ryan Miller, Kevin Benson, Scott Anderson, Richard Hy (newly appointed), 
Kevin Benson, Sec. Cegavske. The purpose of this conference was again to discuss 
next steps necessary to complete the investigation and to plan logistics. Chief Conmay 
again committed to sending Detective Marty to Hawthorne to assist.


4/23/15 - Second Interview of Cherrie George.

Det. Marty and I met with Former-Clerk George at the Hawthorne Care and Share. Det. 
Marty asked George to go over the process by which she conducted the election in 
Hawthorne. George went over the early vote set up process and then how she 
conducted the tally on election night. She indicated that there were no significant 
issues from the PreLat through early voting. 


George described the tally process on November 4 as being without error. Upon further 
questioning, George advised that there was a possibility that the first voting cartridge 
had problems. She recalled that while she tallied this cartridge's votes (or just 
afterwards, she was unable to recall), the software crashed. George said that she said 
something to the effect of, “Oh, here we go again” to the Dominion technician. George 
said that the software had to be restarted on multiple occasions.


George was asked by Det. Marty if there was a process to verify the number of voters 
who signed in and voted against the number of votes cast. She responded that there 
was not. George affirmed that she developed all the processes in the office for 
conducting the elections because when she began her term as Clerk, there were no 
existing procedures. 


During the interview, George was adamant that she had not made any mistakes. She 
continued to deny making any mistakes when confronted with the logs showing the 
different entry modes for the early voting cartridges. She acknowledged that it was not 
standard practice to read vote cartridges in manual mode—but that she did not know 
such a mode existed. 


George said that she was not aware that there was a manual mode function and could 
not fathom why such a function would be present in the software. I showed her the  
screen shot of the source panel from the tally wizard pages of the WinEDS Manuals. 
George said that she had never seen the checkbox to enter manual mode.
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Detective Marty asked George if she had any reason to she would tamper with the 
election. George said no. George was asked if she had any intent to change the 
outcome of the election. Again, George said no. George advised that during the tallying 
process of this election, the technician from Dominion was present and able to observe 
her use of the software. George was unsure of his name but recalled that it might have 
been Max.


Following these questions, Detective Marty and I thanked Ms. George for her 
willingness to discuss these issues with us.


4/23/15 Phone Call - Justus Wendland

After my interview with former-clerk George, I contacted J Wendland to find out who 
was assigned by Dominion to provide onsite technical assistance during the vote. I 
inquired about someone by the name of “Max.” Wendland provided contact 
information for a Bruce Belton, who records show assisted Mineral County —and that 
a Max McCormick had been assigned for the primary election. 


4/23/15 Phone Call - Bruce Belton, Contractor for Dominion Voting Services

28 April 15, Spoke with Bruce Belton by telephone, name given by J Wendlend as 
the Dominion employee in Hawthorne during the November 2014 election. Belton 
confirmed his employment as a temporary technician by Dominion and his placement 
in Hawthorne on November 4. He said that he had assisted in the PreLAT setup of 
Mineral County voting machines and then returned for election night. He said that he 
arrived in Mineral County on November 3, 2014, at approximately 6:00 p.m. He 
reported to the Clerk’s office the following morning. He reported that the day was 
uneventful other than two screens having failed on machines at the library. Belton said 
that he went to the polling location in Schurz at approximately 5:00 and then returned 
to the Hawthorne Library. Upon returning to the Library, Belton took the two machines 
with screen issues out of service. He then returned to the Clerk’s Office to be present 
for vote tabulation. Belton advised that when the software was first started up, he 
recalled that it crashed. He described it as a “system crash” which prompted a 
complete restart of the software. Belton did not notice that any cartridges were read in 
manual mode—and suggested that he was unfamiliar with any manual mode entries.  


Belton said that other than the restart, he did not recall any irregularities in the 
operation of the tabulation software. He added that between the restart and the screen 
issue on the two voting machines, he did not remember any other issues associated 
with the voting in Mineral County.  


Belton said that his background was in wireless systems and that he was now retired. 
He had received some training from Dominion prior to working for them as a temporary 
hire. Belton went on to indicate that if there were any significant problems, he was 
supposed to contact the higher level troubleshooters at Dominion which he did not do 
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in the case of Mineral County’s vote and tally. Further, he was, as a general rule, to 
avoid touching and/or working on any actual voting equipment during the conduct of 
the tabulation. 


Belton was unable to identify any sources to the issues Mineral County had 
encountered. He was unaware that any issues had, indeed, been encountered. He was 
unaware that a cartridge had gone through the tabulation process uncounted, had 
repeated attempts to read, etc. I thanked Belton for his time and input. He said that if I 
had any other questions, to feel free to contact him.  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Attachment: Statement from Justus Wendland
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BARBARA K. CEGAVSKE 
Secretary of State 

 
SCOTT W. ANDERSON 
Chief Deputy Secretary of State 

 
GAIL J. ANDERSON 

Deputy Secretary 
for Southern Nevada 

 

STATE OF NEVADA 

 
OFFICE OF THE 

SECRETARY OF STATE 

JEFFERY LANDERFELT 
Deputy Secretary 

for Commercial Recordings 
 

SCOTT F. GILLES 
Deputy Secretary for Elections 

 
WAYNE THORLEY 

Deputy Secretary 
for Operations 

 

 MEMORANDUM 
 

 
 To: Scott Gilles, Deputy Secretary for Elections   
 
 From: Justus Wendland, HAVA Administrator  
 
 Date: February 2, 2015  
 
 Subject: Mineral County Canvass  

 
 
Due to recent questions about Mineral County’s Canvass for the 2014 General Election you asked 
that I provide you with background on the matter as well as information related to this office’s 
discovery of the vote discrepancy. 
   
Subsequent to the Mineral County Board of County Commissioners canvass and certification of 
the clerk’s abstract of votes, on November 13, 2015, it was discovered that the ballots from a 
voting system results cartridge were not included in the official results. While the reason the 
ballots were not included in the official returns remains unknown to this office, it appears to be a 
software error, human error, or some combination of both. The following segment discusses how 
the discrepancy was discovered as well as different accounts of a potential cause. 
 

x On November 18th, 2014, while preparing informal post-election turnout figures, Gilberto de la 
Luz, Secretary of State staff (“Gilberto”), discovered the number of voter registration records that 
were credited with voting in the election did not match the number reported on the official county 
canvass. This was identified while updating turnout statistics originally published prior to election 
day with final figures. Because of technical limitations the various counties use different software 
programs to report turnout figures before and after the election – this makes it common for a 
county to have different turnout figures before reconciling the two systems.  
 
After different turnout figures for Mineral County were identified, Gilberto contacted the county 
staff Brenda Jones (“Brenda”) who in turn provided the figures to clarify and reconcile the turnout 
numbers. I was made aware of the potential discrepancy by Gilberto as part of a daily progress 
update. At this point, neither I nor Gilberto had any reason for any concern about Mineral 
County’s turnout figures.  
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x On November 18, 2014, after the different turnout figures had been communicated to county staff, 
I received a call from the customer service manager (CSM) for Nevada’s voting system vendor 
Dominion Voting Systems, Inc. (“Dominion). The CSM informed me that the clerk had reached 
out to the vendor for assistance with troubleshooting the turnout figure generated by the voting 
system software. 
 
The CSM indicated that the vendor’s technical staff would be examining the contents of the 
cartridge. This is because the software processing log reported the transfer was “successful” and 
the number of ballots transferred was “0.” The CSM also noted that the Voter Verified Paper Audit 
Trail (VVPAT) recorded around 178 ballots being cast on the voting terminal that the results 
cartridge came from. 
 

x The following day the clerk called to let me know that the county and vendor were still looking 
into the issue and the vendor was thinking this might be a “backup problem.” The clerk also 
indicated that, when the cause was known, a note describing what happened would be kept with 
the results and a copy would be emailed to my attention. 
 
I also received a voice message from the CMS that same day (11/19/2015) day. The CSM 
indicated that this was likely caused by a corrupted cartridge, but Dominion had “no idea why.”  It 
was indicated by Dominion that it was possible that the cartridge was pulled out too soon, which 
usually generates an error. 
 

x On December 16, 2014, this subject resurfaced again during the vendor’s meeting with staff from 
the Secretary of State to discuss the vendor’s election cycle report. During the meeting, the CSM 
explained that the results cartridge was not read by the software because county staff assigned the 
same unique identifier to two (2) results cartridges. It was this action that caused the tabulation 
software to indicate that the transfer of results from the cartridge to the software for both cartridges 
was “successful” when in fact only results on the first cartridge inserted were transferred to the 
software. 
 
The following descriptions are versions of the language to be included in the vendor’s report 
regarding Mineral County. 
 

o Draft - A report was found to have inconsistencies after the Mineral County canvass.   The inconsistencies did 
not change the outcome of any contests on the ballot.  Due to State law that changes cannot be made after the 
canvass, the county documented the inconsistencies but did not change any reports. (CSM 1/9/2015) 

 
o Revision - Mineral County – A memory pack was not tallied. Discovered that two memory packs were assigned 

the same identifier causing the software to not tally votes for 178 ballots on the second cartridge. This also 
caused the processing log to show the cartridge as successfully read. These results were not included on the 
county canvass. (SOS 1/9/2015) 

 
o Suggested Final - Mineral County – A results cartridge was not tallied correctly on Election Night. It was 

discovered the user incorrectly tallied the results cartridge as a manual data entry cartridge with 0 votes instead 
of the 178 ballots on the cartridge. The system then reported the cartridge as tallied preventing the system from 
processing the 178 ballots on Election Night.  These results were not included on the county canvass. (CSM 
1/22/2015) 
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Mineral County Canvass 
2/2/2015 
 

Page 3 of 3 
 

x On January 6, 2015, after the meeting with the vendor, I followed up with the newly elected clerk 
for a copy of note, if any, that was to be left with the canvass. The following day the clerk reported 
that they were unable to locate a note regarding the erroneous omission and that they would follow 
up with the former clerk during a call for other matters to see if such a note existed. Later the 
former clerk called me and confirmed that a note was not left. My understanding for this was that 
the vendor was still not certain about the cause. 
 

x On January 20, 2015, I received a call from the Mineral County District Attorney, Sean Rowe. He 
indicated plans to discourage the clerk’s staff from talking about this matter publicly, and that his 
research had led him to believe that although the results from the early vote machine were not 
properly tabulated it would not void the election. He also shared concerns for the integrity of the 
process in a small community and that he believed it did not appear that anything fraudulent had 
taken place. 
 

x The morning of January 26, 2015, I received two phone calls. One call was from the former clerk 
and the second was from a concerned citizen in Mineral County, Stewart Handte. The former clerk 
shared concern about how this was spreading around the community.  Mr. Handte alleged several 
counts of fraud. 
 
I advised Mr. Handte to first contact the county attorney to report his allegations of elections fraud. 
Mr. Handte informed me that district attorney was “incompetent” and part of the group committing 
the election fraud. On several occasions Mr. Handte noted that he had been with this Mineral 
County law enforcement for 28 years and that he had contacted Nevada’s congressional 
delegation, the governor’s office, and was also going to contact the FBI. While trying to explain 
basic election procedures and regulations to Mr. Handte, I was often interrupted and reminded of 
his background in law enforcement, that he knows the laws, and that an incorrect document is 
fraudulent.  
 
Based on my understanding of the events that took place, my familiarity with the voting system 
and the county election officials, I don’t believe this any malicious activity took place. As an 
educational opportunity that can be learned from I recommend reviewing the actions and events 
that took place. The following steps and best practices should be used while reviewing post-
election materials to develop educational and training materials to strengthen the integrity of the 
county election process. 
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LOG_ID COMPONENT_ID DESCRIPTION EVENT_DATE NAME WORKSTATION_NAMELIST_ORDERNAME

1025 172

Update Cartridge Status status: '11' -> '0'. 

2014-11-14 12:27:42
Election 
Day Tally WINEDSWS 2 sa

1024 172

Insert into Cartridge Status tally mode: '2.000000000000000000', serial number: 
'32746.00000000000000', tally type id: '1.000000000000000000', read date: '11/14/2014 
12:27:41', workstation name: 'WINEDSWS', status: '11', provisional tally type id: '2'. 

2014-11-14 12:27:41
Election 
Day Tally WINEDSWS 2 sa

1022 101

Update Tally Profile tally type id: '3' -> '1.000000000000000000', tally source id: '7' -> 
'4.000000000000000000', source tally mode: '1' -> '2.000000000000000000', source: '0' -> 
'0', tally result: '1' -> '1.000000000000000000', keep images and statistic 2014-11-14 12:27:30

Compon
ents WINEDSWS 0 sa

1023 101

Update Tally Session spid: '54' -> '54', tally profile id: '1' -> '1', workstation name: 
'WINEDSWS' -> 'WINEDSWS', start time: '11/4/2014 20:55:50' -> '11/14/2014 12:27:30', is 
active: '0' -> '1'. 

2014-11-14 12:27:30
Compon
ents WINEDSWS 0 sa

1021 172

Update Cartridge Status status: '11' -> '0'. 

2014-11-04 20:56:29
Election 
Day Tally WINEDSWS 2 sa

1020 172

Insert into Cartridge Status tally mode: '1.000000000000000000', serial number: 
'501396.0000000000000', tally type id: '3.000000000000000000', read date: '11/4/2014 
20:55:54', workstation name: 'WINEDSWS', status: '11'. 

2014-11-04 20:55:54
Election 
Day Tally WINEDSWS 2 sa

1018 101

Update Tally Profile tally type id: '1' -> '3.000000000000000000', tally source id: '4' -> 
'7.000000000000000000', source tally mode: '1' -> '1.000000000000000000', source: '0' -> 
'0', tally result: '1' -> '1.000000000000000000', keep images and statistic 2014-11-04 20:55:50

Compon
ents WINEDSWS 0 sa

1019 101

Update Tally Session spid: '54' -> '54', tally profile id: '1' -> '1', workstation name: 
'WINEDSWS' -> 'WINEDSWS', start time: '11/4/2014 19:37:29' -> '11/4/2014 20:55:50', is 
active: '0' -> '1'. 

2014-11-04 20:55:50
Compon
ents WINEDSWS 0 sa

1017 172

Update Cartridge Status status: '11' -> '0'. 

2014-11-04 19:38:41
Election 
Day Tally WINEDSWS 2 sa

1016 172

Insert into Cartridge Status tally mode: '1.000000000000000000', serial number: 
'32752.00000000000000', tally type id: '1.000000000000000000', read date: '11/4/2014 
19:38:40', workstation name: 'WINEDSWS', status: '11', provisional tally type id: '2'. 

2014-11-04 19:38:40
Election 
Day Tally WINEDSWS 2 sa

1015 172

Update Cartridge Status status: '11' -> '0'. 

2014-11-04 19:38:24
Election 
Day Tally WINEDSWS 2 sa

1014 172

Insert into Cartridge Status tally mode: '1.000000000000000000', serial number: 
'32751.00000000000000', tally type id: '1.000000000000000000', read date: '11/4/2014 
19:38:22', workstation name: 'WINEDSWS', status: '11', provisional tally type id: '2'. 

2014-11-04 19:38:22
Election 
Day Tally WINEDSWS 2 sa

1013 172

Update Cartridge Status status: '11' -> '0'. 

2014-11-04 19:38:05
Election 
Day Tally WINEDSWS 2 sa

1012 172

Insert into Cartridge Status tally mode: '1.000000000000000000', serial number: 
'32750.00000000000000', tally type id: '1.000000000000000000', read date: '11/4/2014 
19:38:04', workstation name: 'WINEDSWS', status: '11', provisional tally type id: '2'. 

2014-11-04 19:38:04
Election 
Day Tally WINEDSWS 2 sa

1011 172

Update Cartridge Status status: '11' -> '0'. 

2014-11-04 19:37:44
Election 
Day Tally WINEDSWS 2 sa

1010 172

Insert into Cartridge Status tally mode: '1.000000000000000000', serial number: 
'32749.00000000000000', tally type id: '1.000000000000000000', read date: '11/4/2014 
19:37:43', workstation name: 'WINEDSWS', status: '11', provisional tally type id: '2'. 

2014-11-04 19:37:43
Election 
Day Tally WINEDSWS 2 sa

1008 101

Update Tally Profile tally type id: '1' -> '1.000000000000000000', tally source id: '4' -> 
'4.000000000000000000', source tally mode: '1' -> '1.000000000000000000', source: '0' -> 
'0', tally result: '1' -> '1.000000000000000000', keep images and statistic 2014-11-04 19:37:29

Compon
ents WINEDSWS 0 sa

1009 101

Update Tally Session spid: '54' -> '54', tally profile id: '1' -> '1', workstation name: 
'WINEDSWS' -> 'WINEDSWS', start time: '11/4/2014 19:19:41' -> '11/4/2014 19:37:29', is 
active: '0' -> '1'. 

2014-11-04 19:37:29
Compon
ents WINEDSWS 0 sa

1007 172

Update Cartridge Status status: '11' -> '0'. 

2014-11-04 19:21:54
Election 
Day Tally WINEDSWS 2 sa

1006 172

Insert into Cartridge Status tally mode: '1.000000000000000000', serial number: 
'32746.00000000000000', tally type id: '1.000000000000000000', read date: '11/4/2014 
19:21:53', workstation name: 'WINEDSWS', status: '11', provisional tally type id: '2'. 

2014-11-04 19:21:53
Election 
Day Tally WINEDSWS 2 sa

1005 172

Update Cartridge Status status: '11' -> '0'. 

2014-11-04 19:21:30
Election 
Day Tally WINEDSWS 2 sa

1004 172

Insert into Cartridge Status tally mode: '1.000000000000000000', serial number: 
'32745.00000000000000', tally type id: '1.000000000000000000', read date: '11/4/2014 
19:21:29', workstation name: 'WINEDSWS', status: '11', provisional tally type id: '2'. 

2014-11-04 19:21:29
Election 
Day Tally WINEDSWS 2 sa
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1003 172

Update Cartridge Status status: '11' -> '0'. 

2014-11-04 19:21:08
Election 
Day Tally WINEDSWS 2 sa

1002 172

Insert into Cartridge Status tally mode: '1.000000000000000000', serial number: 
'32743.00000000000000', tally type id: '1.000000000000000000', read date: '11/4/2014 
19:21:07', workstation name: 'WINEDSWS', status: '11', provisional tally type id: '2'. 

2014-11-04 19:21:07
Election 
Day Tally WINEDSWS 2 sa

1001 172

Update Cartridge Status status: '11' -> '0'. 

2014-11-04 19:20:44
Election 
Day Tally WINEDSWS 2 sa

1000 172

Insert into Cartridge Status tally mode: '1.000000000000000000', serial number: 
'32744.00000000000000', tally type id: '1.000000000000000000', read date: '11/4/2014 
19:20:43', workstation name: 'WINEDSWS', status: '11', provisional tally type id: '2'. 

2014-11-04 19:20:43
Election 
Day Tally WINEDSWS 2 sa

999 172

Update Cartridge Status status: '11' -> '0'. 

2014-11-04 19:20:19
Election 
Day Tally WINEDSWS 2 sa

998 172

Insert into Cartridge Status tally mode: '1.000000000000000000', serial number: 
'32739.00000000000000', tally type id: '1.000000000000000000', read date: '11/4/2014 
19:20:18', workstation name: 'WINEDSWS', status: '11', provisional tally type id: '2'. 

2014-11-04 19:20:18
Election 
Day Tally WINEDSWS 2 sa

997 172

Update Cartridge Status status: '11' -> '0'. 

2014-11-04 19:19:55
Election 
Day Tally WINEDSWS 2 sa

996 172

Insert into Cartridge Status tally mode: '1.000000000000000000', serial number: 
'32737.00000000000000', tally type id: '1.000000000000000000', read date: '11/4/2014 
19:19:54', workstation name: 'WINEDSWS', status: '11', provisional tally type id: '2'. 

2014-11-04 19:19:54
Election 
Day Tally WINEDSWS 2 sa

994 101

Update Tally Profile tally type id: '1' -> '1.000000000000000000', tally source id: '4' -> 
'4.000000000000000000', source tally mode: '1' -> '1.000000000000000000', source: '0' -> 
'0', tally result: '1' -> '1.000000000000000000', keep images and statistic 2014-11-04 19:19:41

Compon
ents WINEDSWS 0 sa

995 101

Update Tally Session spid: '54' -> '54', tally profile id: '1' -> '1', workstation name: 
'WINEDSWS' -> 'WINEDSWS', start time: '11/4/2014 19:14:58' -> '11/4/2014 19:19:41', is 
active: '0' -> '1'. 

2014-11-04 19:19:41
Compon
ents WINEDSWS 0 sa

993 172

Update Cartridge Status status: '11' -> '0'. 

2014-11-04 19:17:49
Election 
Day Tally WINEDSWS 2 sa

992 172

Insert into Cartridge Status tally mode: '1.000000000000000000', serial number: 
'32738.00000000000000', tally type id: '1.000000000000000000', read date: '11/4/2014 
19:17:48', workstation name: 'WINEDSWS', status: '11', provisional tally type id: '2'. 

2014-11-04 19:17:48
Election 
Day Tally WINEDSWS 2 sa

991 172

Update Cartridge Status status: '11' -> '0'. 

2014-11-04 19:16:51
Election 
Day Tally WINEDSWS 2 sa

990 172

Insert into Cartridge Status tally mode: '1.000000000000000000', serial number: 
'32740.00000000000000', tally type id: '1.000000000000000000', read date: '11/4/2014 
19:16:50', workstation name: 'WINEDSWS', status: '11', provisional tally type id: '2'. 

2014-11-04 19:16:50
Election 
Day Tally WINEDSWS 2 sa

989 172

Update Cartridge Status status: '11' -> '0'. 

2014-11-04 19:16:29
Election 
Day Tally WINEDSWS 2 sa

988 172

Insert into Cartridge Status tally mode: '1.000000000000000000', serial number: 
'32741.00000000000000', tally type id: '1.000000000000000000', read date: '11/4/2014 
19:16:28', workstation name: 'WINEDSWS', status: '11', provisional tally type id: '2'. 

2014-11-04 19:16:28
Election 
Day Tally WINEDSWS 2 sa

987 172

Update Cartridge Status status: '11' -> '0'. 

2014-11-04 19:16:00
Election 
Day Tally WINEDSWS 2 sa

986 172

Insert into Cartridge Status tally mode: '1.000000000000000000', serial number: 
'32742.00000000000000', tally type id: '1.000000000000000000', read date: '11/4/2014 
19:15:59', workstation name: 'WINEDSWS', status: '11', provisional tally type id: '2'. 

2014-11-04 19:15:59
Election 
Day Tally WINEDSWS 2 sa

985 172

Update Cartridge Status status: '11' -> '0'. 

2014-11-04 19:15:10
Election 
Day Tally WINEDSWS 2 sa

984 172

Insert into Cartridge Status tally mode: '1.000000000000000000', serial number: 
'32747.00000000000000', tally type id: '1.000000000000000000', read date: '11/4/2014 
19:15:08', workstation name: 'WINEDSWS', status: '11', provisional tally type id: '2'. 

2014-11-04 19:15:08
Election 
Day Tally WINEDSWS 2 sa

983 101

Update Tally Session spid: '54' -> '54', tally profile id: '1' -> '1', workstation name: 
'WINEDSWS' -> 'WINEDSWS', start time: '11/4/2014 18:55:32' -> '11/4/2014 19:14:58', is 
active: '0' -> '1'. 2014-11-04 19:14:58

Compon
ents WINEDSWS 0 sa

982 101

Update Tally Profile tally type id: '4' -> '1.000000000000000000', tally source id: '4' -> 
'4.000000000000000000', source tally mode: '1' -> '1.000000000000000000', source: '0' -> 
'0', tally result: '1' -> '1.000000000000000000', keep images and statistic 2014-11-04 19:14:58

Compon
ents WINEDSWS 0 sa

�2
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981 172

Update Cartridge Status status: '11' -> '0'. 

2014-11-04 18:58:08
Election 
Day Tally WINEDSWS 2 sa

980 172

Insert into Cartridge Status tally mode: '1.000000000000000000', serial number: 
'32734.00000000000000', tally type id: '4.000000000000000000', read date: '11/4/2014 
18:58:07', workstation name: 'WINEDSWS', status: '11', provisional tally type id: '5'. 

2014-11-04 18:58:07
Election 
Day Tally WINEDSWS 2 sa

979 172

Update Cartridge Status status: '11' -> '0'. 

2014-11-04 18:56:56
Election 
Day Tally WINEDSWS 2 sa

978 172

Insert into Cartridge Status tally mode: '1.000000000000000000', serial number: 
'32733.00000000000000', tally type id: '4.000000000000000000', read date: '11/4/2014 
18:56:54', workstation name: 'WINEDSWS', status: '11', provisional tally type id: '5'. 

2014-11-04 18:56:54
Election 
Day Tally WINEDSWS 2 sa

977 172

Update Cartridge Status status: '11' -> '0'. 

2014-11-04 18:55:51
Election 
Day Tally WINEDSWS 2 sa

976 172

Insert into Cartridge Status tally mode: '1.000000000000000000', serial number: 
'32753.00000000000000', tally type id: '4.000000000000000000', read date: '11/4/2014 
18:55:49', workstation name: 'WINEDSWS', status: '11', provisional tally type id: '5'. 

2014-11-04 18:55:49
Election 
Day Tally WINEDSWS 2 sa

974 101

Update Tally Profile tally type id: '4' -> '4.000000000000000000', tally source id: '4' -> 
'4.000000000000000000', source tally mode: '1' -> '1.000000000000000000', source: '0' -> 
'0', tally result: '1' -> '1.000000000000000000', keep images and statistic 2014-11-04 18:55:32

Compon
ents WINEDSWS 0 sa

975 101

Update Tally Session spid: '54' -> '54', tally profile id: '1' -> '1', workstation name: 
'WINEDSWS' -> 'WINEDSWS', start time: '11/4/2014 18:53:24' -> '11/4/2014 18:55:32', is 
active: '0' -> '1'. 

2014-11-04 18:55:32
Compon
ents WINEDSWS 0 sa

973 101

Update Tally Session spid: '54' -> '54', tally profile id: '1' -> '1', workstation name: 
'WINEDSWS' -> 'WINEDSWS', start time: '11/4/2014 18:50:01' -> '11/4/2014 18:53:24', is 
active: '0' -> '1'. 

2014-11-04 18:53:24
Compon
ents WINEDSWS 0 sa

972 101

Update Tally Profile tally type id: '4' -> '4.000000000000000000', tally source id: '4' -> 
'4.000000000000000000', source tally mode: '1' -> '1.000000000000000000', source: '0' -> 
'0', tally result: '1' -> '1.000000000000000000', keep images and statistic 2014-11-04 18:53:24

Compon
ents WINEDSWS 0 sa

971 101

Update Tally Session spid: '54' -> '54', tally profile id: '1' -> '1', workstation name: 
'WINEDSWS' -> 'WINEDSWS', start time: '11/4/2014 18:48:44' -> '11/4/2014 18:50:01', is 
active: '0' -> '1'. 

2014-11-04 18:50:01
Compon
ents WINEDSWS 0 sa

970 101

Update Tally Profile tally type id: '4' -> '4.000000000000000000', tally source id: '4' -> 
'4.000000000000000000', source tally mode: '1' -> '1.000000000000000000', source: '0' -> 
'0', tally result: '1' -> '1.000000000000000000', keep images and statistic 2014-11-04 18:50:01

Compon
ents WINEDSWS 0 sa

968 101

Update Tally Profile tally type id: '4' -> '4.000000000000000000', tally source id: '4' -> 
'4.000000000000000000', source tally mode: '1' -> '1.000000000000000000', source: 
'(null)' -> '0', tally result: '(null)' -> '1.000000000000000000', keep images and 2014-11-04 18:48:44

Compon
ents WINEDSWS 0 sa

969 101

Update Tally Session spid: '54' -> '54', tally profile id: '1' -> '1', workstation name: 
'WINEDSWS' -> 'WINEDSWS', start time: '11/4/2014 18:45:28' -> '11/4/2014 18:48:44', is 
active: '0' -> '1'. 

2014-11-04 18:48:44
Compon
ents WINEDSWS 0 sa

967 174

  . 

Entered data for cartridge 32735 2014-11-04 18:46:13

Machine 
Data 
Entry WINEDSWS 4 sa

965 101

Update Tally Profile tally type id: '4' -> '4.000000000000000000', tally source id: '4' -> 
'4.000000000000000000', source tally mode: '1' -> '1.000000000000000000', source: 
'(null)' -> '(null)', tally result: '(null)' -> '(null)', keep images and statisti 2014-11-04 18:45:28

Compon
ents WINEDSWS 0 sa

966 101

Update Tally Session spid: '54' -> '54', tally profile id: '1' -> '1', workstation name: 
'WINEDSWS' -> 'WINEDSWS', start time: '11/4/2014 18:44:32' -> '11/4/2014 18:45:28', is 
active: '0' -> '1'. 2014-11-04 18:45:28

Compon
ents WINEDSWS 0 sa

964 101

Update Tally Session spid: '54' -> '54', tally profile id: '1' -> '1', workstation name: 
'WINEDSWS' -> 'WINEDSWS', start time: '10/6/2014 14:16:45' -> '11/4/2014 18:44:32', is 
active: '0' -> '1'. 2014-11-04 18:44:32

Compon
ents WINEDSWS 0 sa

963 101

Update Tally Profile tally type id: '3' -> '4.000000000000000000', tally source id: '7' -> 
'4.000000000000000000', source tally mode: '0' -> '1.000000000000000000', source: '0' -> 
'(null)', tally result: '1' -> '(null)', keep images and statistics: '0' -> 2014-11-04 18:44:32

Compon
ents WINEDSWS 0 sa

962 172

Update Cartridge Status status: '11' -> '0'. 

2014-10-06 16:10:55
Election 
Day Tally WINEDSWS 2 sa

961 172

Insert into Cartridge Status tally mode: '0', serial number: '501401.0000000000000', 
tally type id: '3.000000000000000000', read date: '10/6/2014 16:10:20', workstation 
name: 'WINEDSWS', status: '11'. 

2014-10-06 16:10:20
Election 
Day Tally WINEDSWS 2 sa

959 101

Update Tally Profile tally type id: '3' -> '3.000000000000000000', tally source id: '7' -> 
'7.000000000000000000', source tally mode: '0' -> '0', source: '0' -> '0', tally result: '1' -> 
'1.000000000000000000', keep images and statistics: '0' -> '0', resu 2014-10-06 16:10:09

Compon
ents WINEDSWS 0 sa

960 101

Update Tally Session spid: '56' -> '56', tally profile id: '1' -> '1', workstation name: 
'WINEDSWS' -> 'WINEDSWS', start time: '10/6/2014 15:52:23' -> '10/6/2014 16:10:09', is 
active: '0' -> '1'. 

2014-10-06 16:10:09
Compon
ents WINEDSWS 0 sa

�3
172



958 172

Update Cartridge Status status: '11' -> '0'. 

2014-10-06 15:53:11
Election 
Day Tally WINEDSWS 2 sa

957 172

Insert into Cartridge Status tally mode: '0', serial number: '501396.0000000000000', 
tally type id: '3.000000000000000000', read date: '10/6/2014 15:52:37', workstation 
name: 'WINEDSWS', status: '11'. 

2014-10-06 15:52:37
Election 
Day Tally WINEDSWS 2 sa

955 101

Update Tally Profile tally type id: '4' -> '3.000000000000000000', tally source id: '4' -> 
'7.000000000000000000', source tally mode: '0' -> '0', source: '0' -> '0', tally result: '1' -> 
'1.000000000000000000', keep images and statistics: '0' -> '0', resu 2014-10-06 15:52:23

Compon
ents WINEDSWS 0 sa

956 101

Update Tally Session spid: '56' -> '56', tally profile id: '1' -> '1', workstation name: 'BRICE-
DF18CE072' -> 'WINEDSWS', start time: '8/28/2014 15:29:27' -> '10/6/2014 15:52:23', is 
active: '1' -> '1'. 

2014-10-06 15:52:23
Compon
ents WINEDSWS 0 sa

954 172

Update Cartridge Status status: '11' -> '0'. 

2014-10-06 14:16:55
Election 
Day Tally WINEDSWS 2 sa

953 172

Insert into Cartridge Status tally mode: '0', serial number: '32753.00000000000000', 
tally type id: '4.000000000000000000', read date: '10/6/2014 14:16:55', workstation 
name: 'WINEDSWS', status: '11', provisional tally type id: '5'. 

2014-10-06 14:16:55
Election 
Day Tally WINEDSWS 2 sa

951 101

Update Tally Profile tally type id: '4' -> '4.000000000000000000', tally source id: '4' -> 
'4.000000000000000000', source tally mode: '0' -> '0', source: '0' -> '0', tally result: '1' -> 
'1.000000000000000000', keep images and statistics: '0' -> '0', resu 2014-10-06 14:16:45

Compon
ents WINEDSWS 0 sa

952 101

Update Tally Session spid: '54' -> '54', tally profile id: '1' -> '1', workstation name: 
'WINEDSWS' -> 'WINEDSWS', start time: '10/6/2014 13:45:15' -> '10/6/2014 14:16:45', is 
active: '0' -> '1'. 

2014-10-06 14:16:45
Compon
ents WINEDSWS 0 sa

950 159

Update Machine Assignment cartridge made date: '10/6/2014 13:24:44' -> '10/6/2014 
13:54:17'. 

2014-10-06 13:54:17

Create 
Cartridg
e WINEDSWS 4 sa

949 172

Update Cartridge Status status: '11' -> '0'. 

2014-10-06 13:45:49
Election 
Day Tally WINEDSWS 2 sa

948 172

Insert into Cartridge Status tally mode: '0', serial number: '32734.00000000000000', 
tally type id: '4.000000000000000000', read date: '10/6/2014 13:45:48', workstation 
name: 'WINEDSWS', status: '11', provisional tally type id: '5'. 

2014-10-06 13:45:48
Election 
Day Tally WINEDSWS 2 sa

947 172

Update Cartridge Status status: '11' -> '0'. 

2014-10-06 13:45:29
Election 
Day Tally WINEDSWS 2 sa

946 172

Insert into Cartridge Status tally mode: '0', serial number: '32735.00000000000000', 
tally type id: '4.000000000000000000', read date: '10/6/2014 13:45:28', workstation 
name: 'WINEDSWS', status: '11', provisional tally type id: '5'. 

2014-10-06 13:45:28
Election 
Day Tally WINEDSWS 2 sa

945 101

Update Tally Session spid: '54' -> '54', tally profile id: '1' -> '1', workstation name: 
'WINEDSWS' -> 'WINEDSWS', start time: '10/6/2014 13:43:37' -> '10/6/2014 13:45:15', is 
active: '0' -> '1'. 

2014-10-06 13:45:15
Compon
ents WINEDSWS 0 sa

944 101

Update Tally Profile tally type id: '4' -> '4.000000000000000000', tally source id: '4' -> 
'4.000000000000000000', source tally mode: '0' -> '0', source: '0' -> '0', tally result: '1' -> 
'1.000000000000000000', keep images and statistics: '0' -> '0', resu 2014-10-06 13:45:15

Compon
ents WINEDSWS 0 sa

942 172

Insert into Cartridge Status tally mode: '0', serial number: '32733.00000000000000', 
tally type id: '4.000000000000000000', read date: '10/6/2014 13:43:47', workstation 
name: 'WINEDSWS', status: '11', provisional tally type id: '5'. 

2014-10-06 13:43:47
Election 
Day Tally WINEDSWS 2 sa

943 172

Update Cartridge Status status: '11' -> '0'. 

2014-10-06 13:43:47
Election 
Day Tally WINEDSWS 2 sa

940 101

Update Tally Profile tally type id: '4' -> '4.000000000000000000', tally source id: '4' -> 
'4.000000000000000000', source tally mode: '0' -> '0', source: '0' -> '0', tally result: '1' -> 
'1.000000000000000000', keep images and statistics: '0' -> '0', resu 2014-10-06 13:43:37

Compon
ents WINEDSWS 0 sa

941 101

Update Tally Session spid: '54' -> '54', tally profile id: '1' -> '1', workstation name: 
'WINEDSWS' -> 'WINEDSWS', start time: '10/6/2014 13:40:34' -> '10/6/2014 13:43:37', is 
active: '0' -> '1'. 

2014-10-06 13:43:37
Compon
ents WINEDSWS 0 sa

939 101

Update Tally Session spid: '54' -> '54', tally profile id: '1' -> '1', workstation name: 
'WINEDSWS' -> 'WINEDSWS', start time: '10/6/2014 13:36:31' -> '10/6/2014 13:40:34', is 
active: '0' -> '1'. 

2014-10-06 13:40:34
Compon
ents WINEDSWS 0 sa

938 101

Update Tally Profile tally type id: '1' -> '4.000000000000000000', tally source id: '4' -> 
'4.000000000000000000', source tally mode: '0' -> '0', source: '0' -> '0', tally result: '1' -> 
'1.000000000000000000', keep images and statistics: '0' -> '0', resu 2014-10-06 13:40:34

Compon
ents WINEDSWS 0 sa

937 172

Update Cartridge Status status: '11' -> '0'. 

2014-10-06 13:38:39
Election 
Day Tally WINEDSWS 2 sa
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936 172

Insert into Cartridge Status tally mode: '0', serial number: '32747.00000000000000', 
tally type id: '1.000000000000000000', read date: '10/6/2014 13:38:39', workstation 
name: 'WINEDSWS', status: '11', provisional tally type id: '2'. 

2014-10-06 13:38:39
Election 
Day Tally WINEDSWS 2 sa

934 172

Insert into Cartridge Status tally mode: '0', serial number: '32748.00000000000000', 
tally type id: '1.000000000000000000', read date: '10/6/2014 13:38:18', workstation 
name: 'WINEDSWS', status: '11', provisional tally type id: '2'. 

2014-10-06 13:38:18
Election 
Day Tally WINEDSWS 2 sa

935 172

Update Cartridge Status status: '11' -> '0'. 

2014-10-06 13:38:18
Election 
Day Tally WINEDSWS 2 sa

933 172

Update Cartridge Status status: '11' -> '0'. 

2014-10-06 13:37:55
Election 
Day Tally WINEDSWS 2 sa

932 172

Insert into Cartridge Status tally mode: '0', serial number: '32752.00000000000000', 
tally type id: '1.000000000000000000', read date: '10/6/2014 13:37:55', workstation 
name: 'WINEDSWS', status: '11', provisional tally type id: '2'. 

2014-10-06 13:37:55
Election 
Day Tally WINEDSWS 2 sa

931 172

Update Cartridge Status status: '11' -> '0'. 

2014-10-06 13:37:30
Election 
Day Tally WINEDSWS 2 sa

930 172

Insert into Cartridge Status tally mode: '0', serial number: '32751.00000000000000', 
tally type id: '1.000000000000000000', read date: '10/6/2014 13:37:30', workstation 
name: 'WINEDSWS', status: '11', provisional tally type id: '2'. 

2014-10-06 13:37:30
Election 
Day Tally WINEDSWS 2 sa

929 172

Update Cartridge Status status: '11' -> '0'. 

2014-10-06 13:37:09
Election 
Day Tally WINEDSWS 2 sa

928 172

Insert into Cartridge Status tally mode: '0', serial number: '32750.00000000000000', 
tally type id: '1.000000000000000000', read date: '10/6/2014 13:37:08', workstation 
name: 'WINEDSWS', status: '11', provisional tally type id: '2'. 

2014-10-06 13:37:08
Election 
Day Tally WINEDSWS 2 sa

927 172

Update Cartridge Status status: '11' -> '0'. 

2014-10-06 13:36:51
Election 
Day Tally WINEDSWS 2 sa

926 172

Insert into Cartridge Status tally mode: '0', serial number: '32749.00000000000000', 
tally type id: '1.000000000000000000', read date: '10/6/2014 13:36:50', workstation 
name: 'WINEDSWS', status: '11', provisional tally type id: '2'. 

2014-10-06 13:36:50
Election 
Day Tally WINEDSWS 2 sa

925 101

Update Tally Session spid: '54' -> '54', tally profile id: '1' -> '1', workstation name: 
'WINEDSWS' -> 'WINEDSWS', start time: '10/6/2014 13:31:15' -> '10/6/2014 13:36:31', is 
active: '0' -> '1'. 

2014-10-06 13:36:31
Compon
ents WINEDSWS 0 sa

924 101

Update Tally Profile tally type id: '1' -> '1.000000000000000000', tally source id: '4' -> 
'4.000000000000000000', source tally mode: '0' -> '0', source: '0' -> '0', tally result: '1' -> 
'1.000000000000000000', keep images and statistics: '0' -> '0', resu 2014-10-06 13:36:31

Compon
ents WINEDSWS 0 sa

922 172

Insert into Cartridge Status tally mode: '0', serial number: '32746.00000000000000', 
tally type id: '1.000000000000000000', read date: '10/6/2014 13:34:44', workstation 
name: 'WINEDSWS', status: '11', provisional tally type id: '2'. 

2014-10-06 13:34:44
Election 
Day Tally WINEDSWS 2 sa

923 172

Update Cartridge Status status: '11' -> '0'. 

2014-10-06 13:34:44
Election 
Day Tally WINEDSWS 2 sa

920 172

Insert into Cartridge Status tally mode: '0', serial number: '32745.00000000000000', 
tally type id: '1.000000000000000000', read date: '10/6/2014 13:34:27', workstation 
name: 'WINEDSWS', status: '11', provisional tally type id: '2'. 

2014-10-06 13:34:27
Election 
Day Tally WINEDSWS 2 sa

921 172

Update Cartridge Status status: '11' -> '0'. 

2014-10-06 13:34:27
Election 
Day Tally WINEDSWS 2 sa

918 172

Insert into Cartridge Status tally mode: '0', serial number: '32744.00000000000000', 
tally type id: '1.000000000000000000', read date: '10/6/2014 13:34:03', workstation 
name: 'WINEDSWS', status: '11', provisional tally type id: '2'. 

2014-10-06 13:34:03
Election 
Day Tally WINEDSWS 2 sa

919 172

Update Cartridge Status status: '11' -> '0'. 

2014-10-06 13:34:03
Election 
Day Tally WINEDSWS 2 sa

917 172

Update Cartridge Status status: '11' -> '0'. 

2014-10-06 13:33:43
Election 
Day Tally WINEDSWS 2 sa

916 172

Insert into Cartridge Status tally mode: '0', serial number: '32743.00000000000000', 
tally type id: '1.000000000000000000', read date: '10/6/2014 13:33:43', workstation 
name: 'WINEDSWS', status: '11', provisional tally type id: '2'. 

2014-10-06 13:33:43
Election 
Day Tally WINEDSWS 2 sa
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914 172

Insert into Cartridge Status tally mode: '0', serial number: '32742.00000000000000', 
tally type id: '1.000000000000000000', read date: '10/6/2014 13:33:20', workstation 
name: 'WINEDSWS', status: '11', provisional tally type id: '2'. 

2014-10-06 13:33:20
Election 
Day Tally WINEDSWS 2 sa

915 172

Update Cartridge Status status: '11' -> '0'. 

2014-10-06 13:33:20
Election 
Day Tally WINEDSWS 2 sa

913 172

Update Cartridge Status status: '11' -> '0'. 

2014-10-06 13:32:59
Election 
Day Tally WINEDSWS 2 sa

912 172

Insert into Cartridge Status tally mode: '0', serial number: '32741.00000000000000', 
tally type id: '1.000000000000000000', read date: '10/6/2014 13:32:59', workstation 
name: 'WINEDSWS', status: '11', provisional tally type id: '2'. 

2014-10-06 13:32:59
Election 
Day Tally WINEDSWS 2 sa

911 172

Update Cartridge Status status: '11' -> '0'. 

2014-10-06 13:32:25
Election 
Day Tally WINEDSWS 2 sa

910 172

Insert into Cartridge Status tally mode: '0', serial number: '32737.00000000000000', 
tally type id: '1.000000000000000000', read date: '10/6/2014 13:32:24', workstation 
name: 'WINEDSWS', status: '11', provisional tally type id: '2'. 

2014-10-06 13:32:24
Election 
Day Tally WINEDSWS 2 sa

909 172

Update Cartridge Status status: '11' -> '0'. 

2014-10-06 13:31:55
Election 
Day Tally WINEDSWS 2 sa

908 172

Insert into Cartridge Status tally mode: '0', serial number: '32738.00000000000000', 
tally type id: '1.000000000000000000', read date: '10/6/2014 13:31:55', workstation 
name: 'WINEDSWS', status: '11', provisional tally type id: '2'. 

2014-10-06 13:31:55
Election 
Day Tally WINEDSWS 2 sa

907 172

Update Cartridge Status status: '11' -> '0'. 

2014-10-06 13:31:35
Election 
Day Tally WINEDSWS 2 sa

906 172

Insert into Cartridge Status tally mode: '0', serial number: '32739.00000000000000', 
tally type id: '1.000000000000000000', read date: '10/6/2014 13:31:35', workstation 
name: 'WINEDSWS', status: '11', provisional tally type id: '2'. 

2014-10-06 13:31:35
Election 
Day Tally WINEDSWS 2 sa

905 101

Update Tally Session spid: '54' -> '54', tally profile id: '1' -> '1', workstation name: 
'WINEDSWS' -> 'WINEDSWS', start time: '10/6/2014 13:30:28' -> '10/6/2014 13:31:15', is 
active: '0' -> '1'. 

2014-10-06 13:31:15
Compon
ents WINEDSWS 0 sa

904 101

Update Tally Profile tally type id: '1' -> '1.000000000000000000', tally source id: '4' -> 
'4.000000000000000000', source tally mode: '0' -> '0', source: '0' -> '0', tally result: '1' -> 
'1.000000000000000000', keep images and statistics: '0' -> '0', resu 2014-10-06 13:31:15

Compon
ents WINEDSWS 0 sa

903 172

Update Cartridge Status status: '11' -> '0'. 

2014-10-06 13:30:46
Election 
Day Tally WINEDSWS 2 sa

902 172

Insert into Cartridge Status tally mode: '0', serial number: '32740.00000000000000', 
tally type id: '1.000000000000000000', read date: '10/6/2014 13:30:45', workstation 
name: 'WINEDSWS', status: '11', provisional tally type id: '2'. 

2014-10-06 13:30:45
Election 
Day Tally WINEDSWS 2 sa

900 101

Update Tally Profile tally type id: '8' -> '1.000000000000000000', tally source id: '6' -> 
'4.000000000000000000', source tally mode: '0' -> '0', source: '0' -> '0', tally result: '1' -> 
'1.000000000000000000', keep images and statistics: '0' -> '0', resu 2014-10-06 13:30:28

Compon
ents WINEDSWS 0 sa

901 101

Insert into Tally Session spid: '54', tally profile id: '1', user id: '1', workstation name: 
'WINEDSWS', start time: '10/6/2014 13:30:28', is active: '1'. 

2014-10-06 13:30:28
Compon
ents WINEDSWS 0 sa

899 159

Update Machine Assignment cartridge made date: '10/6/2014 13:19:17' -> '10/6/2014 
13:24:44'. 

2014-10-06 13:24:44

Create 
Cartridg
e WINEDSWS 4 sa

898 159

Update Machine Assignment cartridge made date: '(null)' -> '10/6/2014 13:19:17'. 

2014-10-06 13:19:17

Create 
Cartridg
e WINEDSWS 4 sa

897 101

Insert into Machine Assignment serial number: '32753', assignment id: '4', tally type id: 
'4', party id: '0'. 

2014-10-06 13:17:45
Compon
ents WINEDSWS 0 sa

896 101

Delete from Machine Assignment serial number: '32736', assignment id: '4', tally type id: 
'4', party id: '0', cartridge made date: '10/6/2014 09:52:09', layout id: '(null)', machine 
type id: '2'. 

2014-10-06 13:17:28
Compon
ents WINEDSWS 0 sa

895 159

Update Machine Assignment cartridge made date: '10/6/2014 09:13:10' -> '10/6/2014 
10:54:22'. 

2014-10-06 10:54:22

Create 
Cartridg
e WINEDSWS 4 sa

894 159

Update Machine Assignment cartridge made date: '10/6/2014 09:48:55' -> '10/6/2014 
09:52:09'. 

2014-10-06 09:52:09

Create 
Cartridg
e WINEDSWS 4 sa
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893 159

Update Machine Assignment cartridge made date: '10/3/2014 15:01:12' -> '10/6/2014 
09:48:55'. 

2014-10-06 09:48:55

Create 
Cartridg
e WINEDSWS 4 sa

892 159

Update Machine Assignment cartridge made date: '(null)' -> '10/6/2014 09:36:59'. 

2014-10-06 09:36:59

Create 
Cartridg
e WINEDSWS 4 sa

891 159

Update Machine Assignment cartridge made date: '10/3/2014 13:39:48' -> '10/6/2014 
09:32:12'. 

2014-10-06 09:32:12

Create 
Cartridg
e WINEDSWS 4 sa

890 159

Update Machine Assignment cartridge made date: '10/3/2014 13:31:34' -> '10/6/2014 
09:30:59'. 

2014-10-06 09:30:59

Create 
Cartridg
e WINEDSWS 4 sa

889 159

Update Machine Assignment cartridge made date: '(null)' -> '10/6/2014 09:27:01'. 

2014-10-06 09:27:01

Create 
Cartridg
e WINEDSWS 4 sa

888 159

Update Machine Assignment cartridge made date: '(null)' -> '10/6/2014 09:25:57'. 

2014-10-06 09:25:57

Create 
Cartridg
e WINEDSWS 4 sa

887 159

Update Machine Assignment cartridge made date: '10/3/2014 14:09:50' -> '10/6/2014 
09:17:38'. 

2014-10-06 09:17:38

Create 
Cartridg
e WINEDSWS 4 sa

886 159

Update Machine Assignment cartridge made date: '10/3/2014 14:02:06' -> '10/6/2014 
09:15:14'. 

2014-10-06 09:15:14

Create 
Cartridg
e WINEDSWS 4 sa

885 159

Update Machine Assignment cartridge made date: '10/3/2014 13:59:11' -> '10/6/2014 
09:14:11'. 

2014-10-06 09:14:11

Create 
Cartridg
e WINEDSWS 4 sa

884 159

Update Machine Assignment cartridge made date: '10/3/2014 13:57:30' -> '10/6/2014 
09:13:10'. 

2014-10-06 09:13:10

Create 
Cartridg
e WINEDSWS 4 sa

883 159

Update Machine Assignment cartridge made date: '10/3/2014 13:53:54' -> '10/6/2014 
09:12:02'. 

2014-10-06 09:12:02

Create 
Cartridg
e WINEDSWS 4 sa

882 159

Update Machine Assignment cartridge made date: '10/3/2014 13:52:18' -> '10/6/2014 
09:10:44'. 

2014-10-06 09:10:44

Create 
Cartridg
e WINEDSWS 4 sa

881 159

Update Machine Assignment cartridge made date: '10/3/2014 13:51:08' -> '10/6/2014 
09:09:17'. 

2014-10-06 09:09:17

Create 
Cartridg
e WINEDSWS 4 sa

880 159

Update Machine Assignment cartridge made date: '10/3/2014 13:47:46' -> '10/6/2014 
09:07:02'. 

2014-10-06 09:07:02

Create 
Cartridg
e WINEDSWS 4 sa

879 159

Update Machine Assignment cartridge made date: '10/3/2014 13:45:46' -> '10/6/2014 
09:04:43'. 

2014-10-06 09:04:43

Create 
Cartridg
e WINEDSWS 4 sa

878 159

Update Machine Assignment cartridge made date: '10/3/2014 15:13:52' -> '10/6/2014 
09:02:35'. 

2014-10-06 09:02:35

Create 
Cartridg
e WINEDSWS 4 sa

877 159

Update Machine Assignment cartridge made date: '10/3/2014 13:44:06' -> '10/3/2014 
15:13:52'. 

2014-10-03 15:13:52

Create 
Cartridg
e WINEDSWS 4 sa

876 159

Update Machine Assignment cartridge made date: '10/3/2014 13:42:09' -> '10/3/2014 
15:03:27'. 

2014-10-03 15:03:27

Create 
Cartridg
e WINEDSWS 4 sa

875 159

Update Machine Assignment cartridge made date: '10/3/2014 13:27:35' -> '10/3/2014 
15:01:12'. 

2014-10-03 15:01:12

Create 
Cartridg
e WINEDSWS 4 sa

874 159

Update Machine Assignment cartridge made date: '10/3/2014 14:51:37' -> '10/3/2014 
15:00:06'. 

2014-10-03 15:00:06

Create 
Cartridg
e WINEDSWS 4 sa

873 159

Update Machine Assignment cartridge made date: '10/3/2014 13:25:59' -> '10/3/2014 
14:51:37'. 

2014-10-03 14:51:37

Create 
Cartridg
e WINEDSWS 4 sa

872 159

Update Machine Assignment cartridge made date: '10/3/2014 14:44:42' -> '10/3/2014 
14:47:52'. 

2014-10-03 14:47:52

Create 
Cartridg
e WINEDSWS 4 sa
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871 159

Update Machine Assignment cartridge made date: '10/3/2014 13:21:03' -> '10/3/2014 
14:44:42'. 

2014-10-03 14:44:42

Create 
Cartridg
e WINEDSWS 4 sa

870 159

Update Machine Assignment cartridge made date: '10/3/2014 14:34:05' -> '10/3/2014 
14:40:51'. 

2014-10-03 14:40:51

Create 
Cartridg
e WINEDSWS 4 sa

869 159

Update Machine Assignment cartridge made date: '10/3/2014 13:16:26' -> '10/3/2014 
14:34:05'. 

2014-10-03 14:34:05

Create 
Cartridg
e WINEDSWS 4 sa

868 159

Update Machine Assignment cartridge made date: '(null)' -> '10/3/2014 14:09:50'. 

2014-10-03 14:09:50

Create 
Cartridg
e WINEDSWS 4 sa

867 159

Update Machine Assignment cartridge made date: '(null)' -> '10/3/2014 14:02:06'. 

2014-10-03 14:02:06

Create 
Cartridg
e WINEDSWS 4 sa

866 159

Update Machine Assignment cartridge made date: '(null)' -> '10/3/2014 13:59:11'. 

2014-10-03 13:59:11

Create 
Cartridg
e WINEDSWS 4 sa

865 159

Update Machine Assignment cartridge made date: '(null)' -> '10/3/2014 13:57:30'. 

2014-10-03 13:57:30

Create 
Cartridg
e WINEDSWS 4 sa

864 159

Update Machine Assignment cartridge made date: '(null)' -> '10/3/2014 13:53:54'. 

2014-10-03 13:53:54

Create 
Cartridg
e WINEDSWS 4 sa

863 159

Update Machine Assignment cartridge made date: '(null)' -> '10/3/2014 13:52:18'. 

2014-10-03 13:52:18

Create 
Cartridg
e WINEDSWS 4 sa

862 159

Update Machine Assignment cartridge made date: '(null)' -> '10/3/2014 13:51:08'. 

2014-10-03 13:51:08

Create 
Cartridg
e WINEDSWS 4 sa

861 159

Update Machine Assignment cartridge made date: '(null)' -> '10/3/2014 13:47:46'. 

2014-10-03 13:47:46

Create 
Cartridg
e WINEDSWS 4 sa

860 159

Update Machine Assignment cartridge made date: '(null)' -> '10/3/2014 13:45:46'. 

2014-10-03 13:45:46

Create 
Cartridg
e WINEDSWS 4 sa

859 159

Update Machine Assignment cartridge made date: '(null)' -> '10/3/2014 13:44:06'. 

2014-10-03 13:44:06

Create 
Cartridg
e WINEDSWS 4 sa

858 159

Update Machine Assignment cartridge made date: '(null)' -> '10/3/2014 13:42:09'. 

2014-10-03 13:42:09

Create 
Cartridg
e WINEDSWS 4 sa

857 159

Update Machine Assignment cartridge made date: '(null)' -> '10/3/2014 13:39:48'. 

2014-10-03 13:39:48

Create 
Cartridg
e WINEDSWS 4 sa

856 159

Update Machine Assignment cartridge made date: '(null)' -> '10/3/2014 13:31:34'. 

2014-10-03 13:31:34

Create 
Cartridg
e WINEDSWS 4 sa

855 159

Update Machine Assignment cartridge made date: '(null)' -> '10/3/2014 13:27:35'. 

2014-10-03 13:27:35

Create 
Cartridg
e WINEDSWS 4 sa

854 159

Update Machine Assignment cartridge made date: '(null)' -> '10/3/2014 13:25:59'. 

2014-10-03 13:25:59

Create 
Cartridg
e WINEDSWS 4 sa

853 159

Update Machine Assignment cartridge made date: '(null)' -> '10/3/2014 13:21:03'. 

2014-10-03 13:21:03

Create 
Cartridg
e WINEDSWS 4 sa

852 159

Update Machine Assignment cartridge made date: '(null)' -> '10/3/2014 13:16:26'. 

2014-10-03 13:16:26

Create 
Cartridg
e WINEDSWS 4 sa

850 101

Insert into Machine Assignment serial number: '501396', assignment id: '11', tally type 
id: '6', party id: '0'. 

2014-10-03 10:00:31
Compon
ents WINEDSWS 0 sa

851 101

Insert into Machine Assignment serial number: '501401', assignment id: '11', tally type 
id: '6', party id: '0'. 

2014-10-03 10:00:31
Compon
ents WINEDSWS 0 sa

849 101

Insert into Machine Assignment serial number: '501401', assignment id: '11', tally type 
id: '7', party id: '0'. 

2014-10-03 10:00:01
Compon
ents WINEDSWS 0 sa

848 101

Insert into Machine Assignment serial number: '501396', assignment id: '11', tally type 
id: '7', party id: '0'. 

2014-10-03 10:00:01
Compon
ents WINEDSWS 0 sa

847 101

Delete from Machine Assignment serial number: '501401', assignment id: '11', tally type 
id: '7', party id: '0', cartridge made date: '(null)', layout id: '(null)', machine type id: '7'. 

2014-10-03 09:59:43
Compon
ents WINEDSWS 0 sa

846 101

Delete from Machine Assignment serial number: '501396', assignment id: '11', tally type 
id: '7', party id: '0', cartridge made date: '(null)', layout id: '(null)', machine type id: '7'. 

2014-10-03 09:59:41
Compon
ents WINEDSWS 0 sa
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845 101

Insert into Machine Assignment serial number: '501401', assignment id: '11', tally type 
id: '7', party id: '0'. 

2014-10-03 09:59:20
Compon
ents WINEDSWS 0 sa

844 101

Insert into Machine Assignment serial number: '501396', assignment id: '11', tally type 
id: '7', party id: '0'. 

2014-10-03 09:59:20
Compon
ents WINEDSWS 0 sa

843 101

Insert into Machine Assignment serial number: '501401', assignment id: '3', tally type id: 
'3', party id: '0'. 

2014-10-03 09:59:05
Compon
ents WINEDSWS 0 sa

842 101

Insert into Machine Assignment serial number: '501396', assignment id: '3', tally type id: 
'3', party id: '0'. 

2014-10-03 09:59:05
Compon
ents WINEDSWS 0 sa

840 101

Insert into Machine Assignment serial number: '32735', assignment id: '4', tally type id: 
'4', party id: '0'. 

2014-10-03 09:58:37
Compon
ents WINEDSWS 0 sa

839 101

Insert into Machine Assignment serial number: '32734', assignment id: '4', tally type id: 
'4', party id: '0'. 

2014-10-03 09:58:37
Compon
ents WINEDSWS 0 sa

838 101

Insert into Machine Assignment serial number: '32733', assignment id: '4', tally type id: 
'4', party id: '0'. 

2014-10-03 09:58:37
Compon
ents WINEDSWS 0 sa

841 101

Insert into Machine Assignment serial number: '32736', assignment id: '4', tally type id: 
'4', party id: '0'. 

2014-10-03 09:58:37
Compon
ents WINEDSWS 0 sa

835 101

Insert into Machine Assignment serial number: '32750', assignment id: '9', tally type id: 
'1', party id: '0'. 

2014-10-03 09:58:21
Compon
ents WINEDSWS 0 sa

836 101

Insert into Machine Assignment serial number: '32751', assignment id: '9', tally type id: 
'1', party id: '0'. 

2014-10-03 09:58:21
Compon
ents WINEDSWS 0 sa

837 101

Insert into Machine Assignment serial number: '32752', assignment id: '9', tally type id: 
'1', party id: '0'. 

2014-10-03 09:58:21
Compon
ents WINEDSWS 0 sa

834 101

Insert into Machine Assignment serial number: '32749', assignment id: '9', tally type id: 
'1', party id: '0'. 

2014-10-03 09:58:21
Compon
ents WINEDSWS 0 sa

832 101

Insert into Machine Assignment serial number: '32745', assignment id: '5', tally type id: 
'1', party id: '0'. 

2014-10-03 09:58:04
Compon
ents WINEDSWS 0 sa

831 101

Insert into Machine Assignment serial number: '32744', assignment id: '5', tally type id: 
'1', party id: '0'. 

2014-10-03 09:58:04
Compon
ents WINEDSWS 0 sa

833 101

Insert into Machine Assignment serial number: '32746', assignment id: '5', tally type id: 
'1', party id: '0'. 

2014-10-03 09:58:04
Compon
ents WINEDSWS 0 sa

826 101

Insert into Machine Assignment serial number: '32739', assignment id: '5', tally type id: 
'1', party id: '0'. 

2014-10-03 09:58:03
Compon
ents WINEDSWS 0 sa

825 101

Insert into Machine Assignment serial number: '32738', assignment id: '5', tally type id: 
'1', party id: '0'. 

2014-10-03 09:58:03
Compon
ents WINEDSWS 0 sa

827 101

Insert into Machine Assignment serial number: '32740', assignment id: '5', tally type id: 
'1', party id: '0'. 

2014-10-03 09:58:03
Compon
ents WINEDSWS 0 sa

824 101

Insert into Machine Assignment serial number: '32737', assignment id: '5', tally type id: 
'1', party id: '0'. 

2014-10-03 09:58:03
Compon
ents WINEDSWS 0 sa

830 101

Insert into Machine Assignment serial number: '32743', assignment id: '5', tally type id: 
'1', party id: '0'. 

2014-10-03 09:58:03
Compon
ents WINEDSWS 0 sa

829 101

Insert into Machine Assignment serial number: '32742', assignment id: '5', tally type id: 
'1', party id: '0'. 

2014-10-03 09:58:03
Compon
ents WINEDSWS 0 sa

828 101

Insert into Machine Assignment serial number: '32741', assignment id: '5', tally type id: 
'1', party id: '0'. 

2014-10-03 09:58:03
Compon
ents WINEDSWS 0 sa

�9
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823 101

Insert into Machine Assignment serial number: '32748', assignment id: '11', tally type id: 
'1', party id: '0'. 

2014-10-03 09:57:41
Compon
ents WINEDSWS 0 sa

822 101

Insert into Machine Assignment serial number: '32747', assignment id: '11', tally type id: 
'1', party id: '0'. 

2014-10-03 09:57:31
Compon
ents WINEDSWS 0 sa
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From: Tina Polich tina.polich@dominionvoting.com
Subject: FW: NV Mineral County Election Log Questions

Date: April 15, 2015 at 2:49 PM
To: Justus Wendland JWendland@sos.nv.gov
Cc: Sean Rowe (srowe@mineralcountynv.org) srowe@mineralcountynv.org, Kevin Benson kbenson@ag.nv.gov, Julie Hoffman

julie.hoffman@dominionvoting.com

Good Afternoon,
 
Please see the e-mail below from Mark McKinney regarding the log explanations requested.  Please let
me know if you have any other questions.
 
TINA POLICH  |  CUSTOMER RELATIONS MANAGER
 
DOMINION VOTING
1201 18th Street, Suite 210, Denver, CO 80202
1.866.654.8683  |  DOMINIONVOTING.COM

 
602.506.5107 OFFICE
480.205.6025 MOBILE

 
************************ATTENTION*************************
The information in this e-mail and in any attachments is confidential and intended solely for the attention and use of
the named addressee(s).
This information may be subject to legal, professional or other privilege  or may otherwise be protected by work
product immunity or other legal rules.
It must not be disclosed to any person without our authority. If  you are
not the intended recipient, or a person responsible for delivering   it to the
intended recipient, you are not authorised to and must not disclose, copy, distribute, or retain this message or any part
of it.
**************************************************************
 
From: Mark McKinney 
Sent: Wednesday, April 15, 2015 1:59 PM
To: Tina Polich; Eric Coomer
Cc: Waldeep Singh; Mike Frontera; Sheree R. Noell; Julie Hoffman
Subject: RE: NV Mineral County Election Log Questions
 
1. This log entry records that someone has completed a manual data entry for the early vote cartridge
32735. Once entered the data cannot be updated, although the cartridge can be removed from tally. If it
is removed, the results cartridge from the machine can be read into tally or a manual data entry can once
again be done to enter the data into WinEDS.
 
2. Row 60  - manual data entry was done for Early Vote cartridge 32735.
 
3. Row 59 through Row 52 – Someone has started the tally wizard 4 times. Each time you get two log
entries; one is an update of the Tally_Session record and the other is an update of the Tally Profile
record. The entries only indicate that the Tally Wizard was run. They do not indicate that any results
cartridges were loaded into WinEDS. You would see other log entries in that case like those on rows 51
and 50.
Row 51 – Early Vote cartridge 32753 was read into WinEDS. That that the actual cartridges was
uploaded. Manual Data Entry was not done on this cartridge like it was for cartridge 32735 on Row 60.
Row 50 – The status in the Cartridge_Status table for cartridge 32753 was update from 11 to 0 (
'Reading' to 'In Queue').
Rows 49 and 48 are the same entries as above except for cartridge number 32733.
Rows 47 and 46 are also the same as rows 51 and 50 except that the cartridge being read into WinEDS181



Rows 47 and 46 are also the same as rows 51 and 50 except that the cartridge being read into WinEDS
was 32734.
 
MARK MCKINNEY   |   SENIOR DATABASE ANALYST
 
DOMINION VOTING
2010 Redbud Blvd, Suite 110 MCKINNEY TX 75069
1.866.654.8683  |  DOMINIONVOTING.COM
 
720.257.5209 x9215 OFFICE
 
480.205.6025 MOBILE

 
************************ATTENTION*************************
The information in this e-mail and in any attachments is confidential and intended solely for the attention and use of
the named addressee(s).
This information may be subject to legal, professional or other privilege  or may otherwise be protected by work
product immunity or other legal rules.
It must not be disclosed to any person without our authority. If  you are
not the intended recipient, or a person responsible for delivering   it to the
intended recipient, you are not authorised to and must not disclose, copy, distribute, or retain this message or any part
of it.
**************************************************************
 
From: Justus Wendland [mailto:JWendland@sos.nv.gov] 
Sent: Wednesday, April 15, 2015 9:21 AM
To: Tina Polich
Cc: Sean Rowe (srowe@mineralcountynv.org); Kevin Benson; Julie Hoffman
Subject: Election Log Questions
 
Ms. Polich,
I am contacting you during Julie’s absence to facilitate a county request. Mr. Sean Rowe is the District
Attorney for Mineral County, Nevada, is reviewing the attached Election Log Report and would like
background on the following log entries.
 
Sean, please chime in with any additional clarification or questions.
 
Log ID 963, Excel row 64
-Please describe what it taking place and whether these changes are manual or automatic. This appears
to be the first entry on Election Day.
 
Log ID 967, Excel row 60
-Please describe what goes into this entry. For example is this is a default setting or how does a user
enter and back out of this entry?
 
Log IDs 967 thru 976, Excel rows 51 thru 60
-Please explain what is taking place for each entry and compare to what should be happening as it relates
to processing another cartridge such as cartridge 32734 (log id 980 and 979) and cartridge 32733 (log id
978 and 977).
 
Thank you,
Justus Wendland
HAVA Administrator
Office of Secretary of State Barbara K. Cegavske
(775) 684-5650
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(775) 684-5650
www.nvsos.gov
 

ATTENTION: The information in this e-mail and in any attachments is confidential and intended solely for the attention and use of the named addressee(s).
This information may be subject to legal, professional or other privilege or may otherwise be protected by work product immunity or other legal rules. It must
not be disclosed to any person without our authority. If you are not the intended recipient, or a person responsible for delivering it to the intended recipient, you
are not authorized to and must not disclose, copy, distribute or retain this message or any part of it.

183



Attachment: Dominion Voting Systems Manual

WinEDS I for Version 3.1


Tally Support Training Guide 

184



 

WinEDS I for Version 

3.1

 Tally Support  
Training Guide

Document Version 1.00 

185



W i n E D S  I  f o r  V e r s i o n  3 . 1  T a l l y  S u p p o r t  T r a i n i n g  G u i d e  P a g e  | 
!  2

Copyright 
2006-2008 Dominion Voting Systems, Inc. All rights reserved. 

Disclaimer 
DominionDominion Voting Systems, Inc. believes that this manual is accurate and reliable. Dominion 
Voting Systems accepts no responsibility, financial or otherwise, for any consequences arising out of 
the information in or the use of this manual. The information contained in this manual is subject to 
change. Updates may be issued from time to time. 
This manual contains proprietary and confidential information. This document was prepared by 
Dominion Voting Systems and is intended for the exclusive use of its clients and licensees. 
No part of this document may be photocopied or reproduced in any manner without the prior consent 
of Dominion Voting Systems. Dominion Voting Systems does not extend any warranties by this 
document. All product information and material disclosure contained in this document is furnished 
subject to the terms and conditions of a purchase or lease agreement. The only warranties made by 
Dominion Voting Systems are contained in such agreements. Users should ensure that the use of this 
system complies with all legal or other obligations of their governmental jurisdictions. 

Version History 

Date Author Description Software 
Release

Document 
Version

021706 Tech writer Draft 1 based on version 3.0. Sent to G Mathews for 
conversion to 3.1

n/a 0.01

082506 Tech writer Updated based on R Mediratta’s edit of document 
and D Davidson’s email requesting changes 

n/a 0.02

012308 Tech writer Updated based on R Mediratta’s 11/27/07 edit. 
Released document

n/a 1.00
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About This Guide

Purpose 

This document provides procedures for assigning machines to precincts, burning cartridges, 
loading voting machines, and performing election tally. 

Audience 

This document is intended for personnel responsible for overseeing and managing the WinEDS 
election system and warehouse management. 

Scope 

This document provides procedures for assigning machines to precincts, burning cartridges, 
loading voting machines, and performing election tally. This document does not include 
instructions for setting up a WinEDS profile and ballot management. 

Conventions 

This guide uses the following type conventions:  
• New terms and book titles appear in italic type.  
• Required input that you must enter is shown in Courier New font.  
• Required input that may change is shown in Courier New italics font.  
• Text that appears on the screen, such as a computer response or a file name, is 

shown in Arial 10 Bold font.  
• Names of keys on the keyboard that you must click appear with initial capitals 

using Arial 10 Bold font—for example, Click Return.  
• A note provides related, parenthetical information, such as an explanation, tip, 

comment, or other useful, but not imperative, information. 
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1. Overview:  Profile and Election 
Databases

The Profile database contains information entered into WinEDS that is specific to your 
jurisdiction, such as your jurisdiction’s precincts, political subdivisions, political offices, Visio 
templates, voting machine serial numbers and firmware versions, and political parties.  This 
information generally remains the same from one election to the next.  Depending upon how 
the profile database is set up also determines how precincts, tally categories and tally types are 
reported.   
An Election database is created from the profile through WinEDS.  This information is specific 
to a particular election whether it is a primary, general, special or runoff election.  WinEDS 
creates a new election database and a new election log database on your server, in which the 
information for a specific election is stored, such as the contests and candidates that will be in 
the election, the precincts that are voting in the election, any measures or questions, and the 
specific machines that will be used, as well as to which precincts or locations the machines will 
be assigned.  The election and profile database must be kept as one; changes should not be 
made to the profile database once the election is created.   
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2. Machine Assignment

2.1.Introduction 

In Machine Assignment, you can assign specific voting machines to each precinct or location, 
for each tally category, in the current election. For example, you can assign one group of 
machines to Early Vote, and another group to Election Day. 

2.2.Getting to the Right Window 

Machine Assignment is done on the Machine Assignment window in Election Setup. You must 
also have the current election open. 

!  

You can get here from the: 
• Task List, by double-clicking on Machine Assignment 
• Menu Bar, by clicking the Election Setup menu, then selecting Machine 

Assignment 
• Tool Bar, by clicking on the Machine Assignment icon. 

!197



W i n E D S  I  f o r  V e r s i o n  3 . 1  T a l l y  S u p p o r t  T r a i n i n g  G u i d e  P a g e  | 
!  14

2.3.Machine Assignment: Overall Procedure 

1. For each tally category, assign voting machines to each of the precincts or locations in 
your jurisdiction. 

2. Right-click on Machine Assignment in the Task List, and then left-click on Processed, 
to make a check mark that indicates you have completed Machine Assignment (optional). 

2.4.Machine Assignment: Detailed Instructions 

Detailed instructions for Machine Assignment include assigning voting machines to the 
precincts in a tally category. 

2.4.1. Assigning voting machines to the precincts in a tally category 
To assign voting machines to the precincts in a tally category, you must be on the Machine 
Assignment window. 

!  

  Machine Assignment by Precinct window 
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Depending on how the election is setup for each tally category, assign voting machines to each 
of the precincts or locations in your jurisdiction: 
1. Click on the + icon next to a tally category in the Assigned Machines field on the left. 

A list of all the precincts or locations appears under the name of the tally category.  
Precincts are entered on the Precinct tab of the Profile window and tally categories are 
custom preset for your WinEDS system. 

2. For each precinct in the tally category, assign all the voting machines to be used in it: 
a) Select the precinct from the list under the name of the tally category. 
b) For each voting machine to be used in the selected precinct: 

i. Select the machine in the list labeled Unassigned Machines on the right. 
ii. Click on the button with the arrow pointing left. 

The voting machine will appear under the selected precinct. 
You can remove a voting machine from the Assigned list by selecting it and clicking on the 
button with the arrow pointing right. 

3. Be sure to repeat this procedure for each tally category that will be used in the current 
election. 
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3.  Registration

3.1.Introduction 

In WinEDS 3.1, there are two methods for managing registration. Let’s refer to them as 
Simple / Complex and Standard registration.  

3.2.Simple Registration 

Simple registration is located with the precinct information and can be displayed by viewing the 
top portion of the Precinct Maintenance “Registration” tab of an individual precinct (see figure 
below). This registration information is very straightforward and can not account for 
registration by party or by PSD—only a total for a precinct (active and inactive). This 
registration accounts for the totals in WinEDS if Standard registration is not imported or 
entered. The location of the table is in the Profile database, and each Election connected with 
that Profile would use the same precinct registration information. 

!  

    The Precinct Maintenance window (Registration tab) 

3.3.Complex Registration 

Complex registration accommodates party and PSD split registration. These figures are seen in 
the Precinct Maintenance “Registration” tab in the Party Registration Information pane of 
the screen (see figure above). This registration accounts for the totals in nearly all of the 
WinEDS reports including all 3 Column Summary reports, HTML report, Fixed Summary, and 
Statement of Vote reports. Two copies of this information is stored—one in the profile and one 
in the election. The profile version stores the information shown in the lower pane, while the 
election version provides the information for the reports listed in the top pane of the figure 
shown above. 
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3.4.Best Methods 

There are two methods to get registration totals into the election from either the Profile records 
or from external sources. The next two sections will cover those two methods. 
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4. Registration – Simple (Manual Entry)

4.1.Introduction 

This is the most common way to get registration figures into the registration table for small 
municipal or special elections. This copies only the total registration numbers and does not 
transfer the party or PSD information. 

4.2.Manual Entry 

If you have updated the registration totals in the Precinct Maintenance window, follow the steps 
below to manually copy those figures to your election.  
1. Select the Tools > Import > Registration. 

The Registration Data Import Utility appears. 

!  

2. Move all Precincts from the Available precincts (right) side to the Precinct to import 
(left) side. 

3. If you have older registration figures for party or PSD in the Profile that you do not wish 
to overwrite, uncheck the Profile Database box.  
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4. Press the Copy button to begin the copy process. 
5. Press the Cancel button to exit.  

Notice it will prompt you for files if you press the OK button. 
6. Compare your registration in both Summary report and 3-Column Summary report with 

your own figures. 
Note: There are Registration reports also that can be proofed. 

!204



W i n E D S  I  f o r  V e r s i o n  3 . 1  T a l l y  S u p p o r t  T r a i n i n g  G u i d e  P a g e  | 
!  21

5. Registration – Standard (Import 
Wizard)

5.1.Introduction 

This is the most common way to get registration figures into the registration table for larger 
general, primary, and municipal elections. This method copies the total registration numbers as 
well as the party or PSD information from an external data source. 

5.2.Importing Registration 

If you would like to update the registration totals from an external voter registration source, 
follow the steps below to import those figures to your election from a series of tab delimited 
files.  
1. Select the Tools > Import > Registration.  

The Registration Data Import Utility appears. 
Note: Refer to Chapter 4’s figure of the Data Registration Import Tool in its native state to 
review the layout of the tool. 
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As shown in the above figure, all the precincts have been moved to the Precincts to 
import side. The Clear Current Party Data Before Import checkbox has also been 
selected. 

2. Move all Precincts from the Available precincts (right) side to the Precinct to import 
(left) side.  

3. On the Party Tab move all parties. 
4. If you have older registration figures for party or PSD in the Profile that you do not wish 

to overwrite, uncheck the Profile Database box.  
This step is optional, but recommended. 

5. Load up your two-tab-delimited data files.  
The format for these files is covered in the next section.  
Note: You must import both files, even for a general or municipal election. 

6. To clear out all party registration data in the target databases, check the Clear Current 
Party Data Before Import.  
This step is optional. Generally, you will know what to do here based on whether you are 
importing all of the parties data or just one parties data (e.g. Natural Law party only). 

7. Press the OK button to begin the import process. 
8. Press the Cancel button to exit.  

!206



W i n E D S  I  f o r  V e r s i o n  3 . 1  T a l l y  S u p p o r t  T r a i n i n g  G u i d e  P a g e  | 
!  23

Notice the tool will prompt you to overwrite files if you press the OK button. Unless you 
want to import the data a second time, hit the Cancel button. 

9. Compare your registration in the Summary report with your own figures. 

5.3.File Formats 

The file formats for the two tab-delimited files is covered in the Tools section of the WinEDS 
3.1 manual. 

5.3.1. File 1 – The Precinct File 
The data from this file will be used to update the simple registration table in Profile (recall that 
this table provides the information for the Summary Report in your elections). This file will 
have three (3) columns in it. The contents of those columns are listed below: 

Assignment_Code (7) Active_Voters (6) Inactive_Voters (6)

Row 1 750 1753 0

Row 2 751 2546 0

Row 3 753 2401 0

Row 4 755 955 0
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6. File 2 – The Precinct-Party File 
The data from this file will be used to update the complex registration table in Profile (if 
checked) and the Election. This file will have five (5) columns in it. The contents of those 
columns are listed below: 

6.4.Clarifications 

6.4.1. Assignment Code 
This is a seven (7) digit alpha/numeric code located in the Precinct Maintenance (General tab). 
If the precinct names are numeric or alpha/numeric, then this is usually the same as the name of 
the precinct. 

6.4.2. Party List Order 
View the list of parties and their list orders in the Party window of Profile. Each party has a list 
order based on what order they appear on reports. Use the number under the List Order column 
(see figure below). 

!  
    The Party tab of the Profile window. Note the list order column. 

Assignment  
Code (7)

Party List 
Order (3)

P S D _ I D 
(7)

Active_Voters 
(6)

Inactive_Voters 
(6)

Row 1 750 3 0 1753 0

Row 2 751 3 0 2546 0

Row 3 753 3 0 2401 0

Row 4 755 3 0 955 0
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6.4.3. The Non-Partisan Party 
When you create the files for the Precinct-Party File for a Municipal, General, or Special 
election, you must still specify a party for the Party List Order. The party that you use is the 
Non-partisan party (shown in the figure above with a list order of 1). 

6.4.4. PSD_ID 
For most all applications, you will place a zero (0) in this column. For importing registration 
results for split precincts, you must get a valid PSD_ID for each portion of the split to track the 
registration. This is not commonly done.  
Note: To get the PSD_ID of your split PSDs, run the VIEW_SPLIT_PRECINCTS.sql and find 
the PSD_ID set in the list. 

6.4.5. Active Voters 
This one is pretty straight-forward. Enter the number (up to six digits) for voters in the defined 
group or split. 

6.4.6. Inactive Voters 
If you do not track Inactive Voters, you can enter a zero (0) in this column. Alternatively you 
can uncheck the inactive voter checkbox at the bottom of the Registration Data Import Tool to 
ignore Inactive Voters. 
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6. Creating Results Cartridges

6.1.Introduction 

In order to get the election from WinEDS onto the Edge machines, the appropriate election files 
must be put on results cartridges.   

6.2.Machine Type Maintenance – Machine Settings 

Prior to creating cartridges for an election, machine settings need to be defined in the Machine 
Type Maintenance screen.  All of the defined settings will then be passed to the Edges during 
that election cycle. It is of great importance that these settings be reviewed and tested prior to 
creation of the bulk of the Official election cartridges.  
Refer to WinEDS II Election Management Training Guide for a list of Machine Parameters for 
the EDGE2plus. 

6.3.Creating Cartridge Labels 

Follow the steps below to create labels for Results cartridges. 
1.   Open WinEDS, and then open the appropriate official election. 
2. From the menu bar, click Election, and then click Reporting. 

The Reports window is displayed. 
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3. Click the + sign to expand the Cartridge tree. 
4. Depending on the desired sort, double click Cartridge Labels (Assignment Code) or 

Cartridge Labels (Layout Name). 
The cartridge labels are produced in WinEDS. 
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5. Print the cartridge labels by clicking the Print icon. 
6. Label the cartridges with their appropriate precinct/polling place label. 

6.4.Creating Results Cartridges 

Follow the steps below to create results cartridges. 
1. Before creating results cartridges, it is recommended that the results cartridges be already 

labeled—to facilitate verification that the correct machine number is being chosen for the 
cartridge being created / inserted into the cartridge reader. 

2. From the menu bar, click Election Setup, and then click Create Cartridge. 
The Create Cartridge window is displayed, and the Assigned Machines tab should be 
selected.  

3. Double-click on the name of the tally category in the list. 
Note: The machines are listed under each precinct or voting location depending on how the 
election is conducted. 
In an Election by Precinct, a list of all the precincts appears under the tally category. 
In an Election by Location, a list of all the voting locations appears under the tally 
category. 

4. Create a cartridge for each voting machine used in the tally category.  
Note: You can create cartridges by selecting the individual specific machine number, or 
you can create cartridges by selecting a range of machine numbers for all machines 
assigned to a particular precinct or voting location. 

6.4.1. Creating by Individual Specific Voting Machine 
To select a specific voting machine for which to create a cartridge, do the following: 
1. Double-click on the name of the precinct or location to display all the machines that are 

assigned to it. 
2. Select the specific machine. 
3. Click Create. 

The Create AVC Edge Cartridge window is displayed and shows the number of the 
selected voting machine in the Serial Number field. 
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4. Insert the Results cartridge in the card reader.  
Note: The Cartridge Status image in the upper right-hand corner indicates the cartridge is 
inserted.  

5. Confirm that the correct path is selected for the card reader. To change the path, click the 
Set button. 
The Set Edge Source window is displayed.   

6. Select the correct path. 
7. To create audio files, check the Audio box. 
8. If setting up a HAAT, to create HAAT files, click the HAAT Configuration Files box. 
9. Select the languages from the Languages checkbox list that are to be included on the 

cartridge.  
Each language that was added during the System Setup will appear in this list.  
Note: Although English will show up in the list, it cannot be un-checked and will always be 
included in the Edge cartridge creation.  

10. Click Start to create the cartridge.  
The Cartridge Status image in the upper right-hand corner changes to indicate that the 
cartridge is being created. When WinEDS has finished creating the cartridge, the Cartridge 
Status image will change to indicate the cartridge creation is complete and that the 
cartridge can be removed.   

11. Remove the cartridge and close the Create Cartridge window. 
Note: Once you are through with the Create Cartridge window, you can select another 
specific machine and create a cartridge for it. Be sure to repeat this procedure for each 
machine in each tally category that is used in the current election. 
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7. Creating Supplementary Cartridges 

7.1.Creating Card Activator (Auto Activate) Files 

7.1.1. Exporting auto activate files to a cartridge 
Using WinEDS, follow the steps below to export auto activate files (for the Card Activator) to a 
cartridge. 
1. Open the appropriate election in WinEDS. 
2. Insert a cartridge.  
3. From the menu bar, click Tools, Export, and Auto Activate Files. 

The Export Auto Activate Files window appears. 
4. Make sure the path is set pointing to the cartridge. 
5. Select precinct or tally type. 
6. Click Export. 

When the export is complete, the message Data Successfully Exported is displayed. 

7.1.2. Programming the Card Activator  
To conduct Pre-Election LAT, you will need to program the Card Activator. The Card Activator 
is a small device used at the polls to activate voter cards for each voter.  
As the vote simulation process mimics voters voting on the Edge, voter cards will need to be 
activated for vote simulation. Before voter cards can be activated, however, the Card Activator 
must be programmed with the current election files. 
Follow the steps below to program the Card Activator: 
1. Turn the Card Activator on. 
2. Insert the cartridge that contains the card activation files for your ballot. 
3. Press the Menu button. 

The menu appears. 
4. Press 3 for Election. 

Another menu appears. 
5. Press the down arrow, and then press 5 for Set Election. 

The message Copying Election bin information is displayed. The Card Activator copies 
the appropriate files from the cartridge. 
Once finished, depending on the firmware version, the system asks Do you want to 
reboot?  

6. Press Yes. 
The Card Activator reboots, and is now programmed to activate voter cards. 

7. Remove the cartridge from the Card Activator. 
8. Activate voter cards as needed. 
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8. Configuring HAAT

The HAAT (Hybrid Activator, Accumulator, and Transmitter unit) is the component that 
enables voters to access the Edge2Plus and Edge2 direct-record electronic touch-screen 
voting machines. The HAAT Unit is used to consolidate, tally, print, and transmit unofficial 
election results; depending upon the model of HAAT used and the firmware loaded. 

To load the HAAT configuration files in WinEDS: 

From the Tools menu, select HAAT Configuration. 
In the AVC Edge Message File box, choose from the following options: 

1. To load the HAAT configuration file: 

2. In the HAAT ConfigFile section, click Load File.In the Pick HAAT Config File 
dialog box, locate and select the .ini configuration file. 

3. Click Open. 

1. To load the HAAT certificate: 

2. In the HAAT Certificate File section, click Load File. 

3. In the Pick CA Certificate File dialog box, locate and select the .crt certification file. 

4. Click Open. 

1. To load the HAAT authentication: 

2. In the HAAT Authentication File section, click Load File. 

3. In the Pick HAAT Authentication File dialog box, locate and select the .txt 
authentication file. 

4. Click Open. 

1. To load the Print Document Setting file, Error Code String file, or Application 
String file: 

2. Click Load File in the applicable section. 

3. Locate and select the .xml file. 

4. Click Open. 
The selected files appear on the right side of the dialog box. 

5. Click OK. 

Preparing the HAAT 
Before Election Day, each HAAT Unit must be prepared with the election-specific information 
for its destination precinct / Location. This procedure can be performed using either a PCMCIA 
or an USB preparation Stick, depending on the model of the HAAT. For best results, it is 
recommended to prepare the unit using an USB Stick. 
NOTE: Only ONE Preparation Cartridge may be inserted at a time. 
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NOTE: HAAT50 Units can be prepared using USB Preparation Cartridges ONLY. 
NOTE: The PCMCIA cartridge / USB Stick should contain both the ‘Root’ and the ‘HAAT’ 
folder 
Do the following to prepare the HAAT Unit: 
1. Press the MENU button to access the HAAT Unit Menu. 

The following menu is displayed. 
7. Set DateTime 
8. Test unit 
9. Prepare unit 
0. Upgrade 

2. Press number 9 using the numeric keypad to select the “Prepare unit” option.  
The message Insert Preparation cartridge and press YES is displayed. 

3. Insert the USB preparation memory stick in the HAAT Unit’s USB port and press the 
YES button. 

4. If you are using a PCMCIA preparation cartridge, insert the cartridge into the PCMCIA 
insertion slot when prompted. 

NOTE: In order to prepare the HAAT that is already setup with an earlier election, the HAAT 
should be Reset first. 
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8.1.Creating Simulation Files and Cartridges 

On the AVC Edge Script Editor window, you can create a vote simulation script and load it onto a 
vote simulation cartridge. 
When conducting a pre-election Logic and Accuracy Test i.e. Pre-LAT, the AVC Script Editor is 
used to create a sequence of simulated votes that are loaded onto a Vote Simulation cartridge.  
This provides a method to have a predetermined vote pattern executed at the voting machine, 
ensuring the machine is operating correctly and the ballot is correctly defined.  Complete 
operational procedures for using the vote simulation with the AVC Edge are found in the AVC 
Edge Operations guide. 

1. Go to Tools // Cartridge Utilities // AVC Edge window and click on the Menu button.   
2. Select Script from the menu.   

The AVC Edge Script Editor window opens. 

!  

3. Create the script needed. 

8.1.1. Getting Started 
• Click in the AVC Edge Script Editor window and write the sequence of commands 

that comprises the script and consists of Candidate ID's. 
• The simulated votes follow each other directly in a list. 
• You must enter the sequence of commands for each vote.  You can use the Copy 

and Paste commands on the Edit menu to save time in creating the sequence of 
simulated votes.   

• You can add comments for your own use by preceding the comment text with a /.  
For example, /First vote pattern repeats six times. 
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8.1.2. Entering selection code and/or language code in script 
1. If the ballot definition calls for a selection code, you must enter the selection code.  For 

example, enter AC 238 to enter selection code number 238. 
Enter the selection codes according to the ballot definition. 
Note:  A ballot definition report can be generated for a specific machine, precinct or Early 
Voting cartridge by selecting Tools > Cartridge Utilities > Menu > Reports and using the 
drop down box select the Ballot Definition Report and select Run.  Make sure when you 
are in the Cartridge Utilities Menu you select the correct path of the cartridge with the 
ballot and or precinct information on it. 

2. If no selection code, enter the activate command: AC. 
3. If there is a selection for language, before entering the candidate position, you must first 

enter the language code.  For example, enter L0 for English, L1 for the next language and 
L2 for the subsequent language, etc. 
Enter the language codes according to the ballot definition. 

4. Enter the candidate position for each selection that comprises the vote.  For example, type 
2 to enter a vote for candidate ID 2.  To obtain a candidate's ID number, print the Ballot 
Definition Report. 

▪ Each candidate you wish to cast a vote for must be typed on a separate line in the 
script. 

▪ When "Write In" is permitted, you can include a write in by using the write in 
command.  For example, if position 14 contains a Write In as its candidate, and you 
want to cast a vote for John Jones, enter 14, and then on a new line enter  John 
Jones. 

5. Enter the cast vote command: CV. 
Note:  Remember, you must enter the sequence of commands for each vote. 

6. To repeat the above set of commands (votes), enter 'R' and then enter the number of the 
line from which command should start followed by how many times it should re-run. 
(e.g. R1 2 - meaning Repeat from line 1 twice). 

8.1.3. Saving and loading a script to a vote simulation cartridge 
Follow the steps below to save and load a script to a simulation cartridge. 
1. On the File menu, select Save As to save the script to a file.   

Once you have saved a script, its file name (*.scr) along with the full path appears in the 
title bar of the AVC Edge Script Editor window. 

2. On the File menu, select Print to print the script. 
3. Load the script to a vote simulation cartridge. 

▪ Insert a vote simulation cartridge in the cartridge reader. Set the correct path pointing 
to the cartridge 

▪ Click the Generate Simulation Cartridge button on the AVC Edge Script Editor 
window.  The script will appear in the pane at the bottom of the AVC Edge Script 
Editor window. 

▪ Remove the vote simulation cartridge from the cartridge reader. 
You do not need to load the script when you write it.  It can be saved and loaded at any 
time. 
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9. 400-C Machine Pre-LAT Setup

9.1.Introduction 

The 400-C tally type is an external Absentee tally whose source is the Dominion 400-C. 
In order to prepare the 400C for running Absentee ballots, the 400C files from WinEDS 
must first be created, and then imported into the 400C computer (WinETP).   

9.2.Generating 400-C Machine Election Files from WinEDS 

Follow the steps below to generate 400C election files from WinEDS. 
1. Go to Election Setup \\ Ballot Management \\ Optech tab. 
1. Right click anywhere in the left screen where the ballot styles for your Optech ballots are 

shown in the Optech Ballot tab. 
2.     Select Export 400-C. 

A dialog box will pop open (shown below). 

!  

2. Place a blank floppy in the diskette drive or you can use a USB memory stick  
3. For the Election Path, enter the drive letter of the disk or USB memory stick and file 

folder where the 400-C files are to be created.  
4. For the Election Name, enter a one-to-eight character descriptive file name, such as 

mygenl or prim01. 
Limit the name to eight characters or less!  This name will be the election filename for 
WinETP. 

5. Ensure Create for Re-Count is un-checked. 
6. Click on Start. 

Progress bars will scroll as files are copied to the floppy. This box does not automatically 
close when the files are done being copied.  

7. A Export Complete window will appear.  Click on OK to close this then click Close to 
exit.  

8. Remove the floppy disk or USB and take it over to the 400-C to load the files on that 
machine. 
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NOTE: If the system is networked the files can be exported to the network drive. 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9.3.Loading 400-C Machine Election Files onto 400-C 

Follow the steps below to load 400C files to the 400C machine. 
1. Insert the WinEDS/EMS disk into the computer’s disk drive (A drive). 
2. Select New from the File menu. The following Get Election Files dialog box will be 

displayed. 

!  

Figure 91:  Get Election Files Dialog Box 

NOTE: Cancel: Cancels the operation, and closes the Get Election Files dialog 
box. 

3. Source: Enter the WinEDS/EMS disk location (where the WinEDS/EMS files will be 
copied from). Example A:\Egldem4c 

4. Destination: Will normally be C:\elecdata. 
Used to enter the location where the WinEDS/EMS files will be copied to. 

5. Select WinEDS/EMS Files (.ofc, .rpt,. pre). Indicates that the files being copied over 
will be WinEDS/EMS files. 

6. Select OK. The files will be copied to the computer’s hard drive (C drive), and the 
blank WinETP Main window will be re-displayed, per Figure 6-1. 

The 400-C is now ready to tabulate. 
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10. Conducting Pre-LAT

10.1.Introduction 

Complete pre-election logic and accuracy testing (LAT) entails running vote simulation on the 
Edge machines, running a test deck through the 400-C and/or Insight, tallying cartridges and 
importing 400-C results into WinEDS.   

10.2.Conducting Pre-LAT on AVC Edge® Machines 

Follow the steps below to conduct Pre-LAT on AVC Edge® machines. 
1. Load the election on the Edge by inserting the results cartridge into the results cartridge 

port. 
2. Begin vote simulation by inserting vote simulation cartridge into auxiliary port. 
3. Perform any other manual votes on the Edge as desired (tactile/hand vote(s), audio 

vote(s), provisional/challenge vote(s). 
4. Compare Edge results tape to vote simulation script and any manual votes put on the 

Edge. 
5. If using audit trail cartridge to tally results, create audit trail cartridge. 
Note:  Remember, the primary reason for using this function in the pre-LAT process is to read 
pre-election vote totals into WinEDS’s pre-election tally mode, and to ensure cartridge 
readability as well as the WinEDS tabulation logic and accuracy by verifying expected vote 
simulation pattern totals on the WinEDS vote summary report.  

10.3.Creating an Audit Trail Cartridge 

While a results cartridge may also be used for this purpose, we recommend creating an Audit 
Trail cartridge to minimize the handling of the results cartridge at this point in the Edge election 
preparation stage.  
Follow the steps below to create an Audit Trail cartridge for pre-election tabulation. 
Note: The audit trail should be copied only onto a cartridge that has been formatted as an Audit 
Trail Transfer cartridge. 
1. Once the Polls have been closed with the Pre-Election LAT Voter Inactive screen 

displayed, press and hold the yellow Activate button for 3 seconds. 
2. When the AVC Edge® beeps, release the button. 
3. Immediately, press and hold the yellow Activate button again for another 3 seconds. 
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4. Release the button when the following screen appears. 

!  

5. Press the Audit Trail Transfer button. 
The AVC Edge® returns the prompt Are You Sure? 

6. Press Yes to continue, or Cancel to return to the Technician Functions screen. 
The AVC Edge® prompts for the Audit Trail cartridge to be inserted into the Auxiliary 
Port. 

7. Insert the cartridge into the Auxiliary Port. 
If the Audit Trail cartridge is not blank, the prompt asks if you want to erase the cartridge. 

8. Press Yes to erase and continue or Cancel to return to the Technician Functions screen. 
The Audit Trail files are copied to the cartridge and verified. This process may take several 
seconds. 
The AVC Edge® displays the message Transfer Successful.  

9. Remove the Audit Trail cartridge.  
Note:  Do not remove the results cartridge. 
The AVC Edge® returns to the Technician Functions screen. 
Note:  To format a cartridge to be an audit trail cartridge take a blank cartridge, In WinEDS 
select Tools > Cartridge Utilities > AVC Edge (set the path to the location of your 
cartridge) > Menu > Format > (use drop down) select Audit Trail > Ok.  It is not 
necessary to enter a machine number. 
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10.4.Conducting Pre-LAT on 400-C Machines 

Run 400-C test desk according to the one of the following options. 

Procedure 
Option

Procedure

A Summary: Tabulate, backup, zero out 400-C before reading next batch. Read 
backup files into WinEDS. (Absentee results not being retained on 400-C – 
incremental tallies into WinEDS). 

Details: 
a. 400-C , run a number of batches (Mixed Mode) or Precincts (in 

Precinct Header Mode).  
b. Clean diskette or usb memory stick placed in machine, results 

backed up to diskette or usb and read into WinEDS, then placed 
aside for safe keeping. Might be a good time for machine 
maintenance. 

c. 400-C machines are reset (zeroed). Repeat process with a new set 
of ballots. 

B Summary: Tabulate, backup to diskette, do NOT zero 400-C. Read diskette backup 
into WinEDS. (Absentee results ARE being retained on 400-C – incremental tallies 
into WinEDS). 
Details: 

a. 400-C, run a number of batches or Precincts. 
b. Clean diskette placed or usb memory stick in machine, results 

backed up to diskette in machine, and read into WinEDS, then 
placed aside for safe keeping. Might be a good time for machine 
maintenance. If using more than one 400-C, the backup-tally 
procedure should be done to all machines as a group (e.g. all at 
the same time).  

c. Continue reading with next batch (next batch number) or precincts. 
Repeat backup with new diskette or USB memory stick and 
machine maintenance procedure.

C Summary: Tabulate, backup to diskette, wait until ALL ballots read before tally into 
WinEDS. 400-C tally is done once at end. (Absentee results ARE being retained on 
400-C – final tally into WinEDS done once at end). 
Details: 

a. 400-C starts a run. A number of ballots are read to some defined 
breaking point. 

b. Clean diskette or usb membory stick placed in machine, results 
backed up to diskette, and placed aside for safe keeping. Might be 
a good time for machine maintenance. 

c. Continue reading ballots by starting next batch (next batch number) 
or precincts. Repeat backup with new diskette and machine 
maintenance procedure. 

d. When finished reading all batches or precincts, take final backup 
diskette to WinEDS station for 400-C Tally. 

Remember, there is no method currently available that will allow the merging of 400-
C results from different machines onto a single 400-C.

!227



W i n E D S  I  f o r  V e r s i o n  3 . 1  T a l l y  S u p p o r t  T r a i n i n g  G u i d e  P a g e  | 
!  44

This page is intentionally left blank. 

!228



W i n E D S  I  f o r  V e r s i o n  3 . 1  T a l l y  S u p p o r t  T r a i n i n g  G u i d e  P a g e  | 
!  45

11. Conducting Tally

11.1.Introduction 

Prior to tallying in WinEDS, a zero proof summary report will be printed from the pre-LAT 
tally mode to show that no vote totals reside in the system.   
Following, results cartridges (or audit trail cartridges) will first be read into WinEDS in pre-
LAT tally mode.  Once this has been completed, a summary report will be printed and 
compared to the Edge vote simulation script (being sure to account for any manual votes placed 
on the Edge).   
After results cartridges have been tallied, an import of the results from the 400C will be 
imported into WinEDS, once again, in pre-LAT tally mode.  A summary report will be printed 
and compared against the totals from the Edge vote simulation script and 400-C test deck script. 

11.2.Starting Tally 

To begin the tally process, you must have completed Election Setup and begun the election. 
From the Election Day menu on the menu bar, click Begin Tally.  The first time that you begin a 
tally, the system will create the tally data store— including the election summary table, turnout 
summary table, processed precinct table, and precinct summary table. 
In Tally Processing, you will use the Tally Wizard to tally votes for the PreLAT / Official 
Election from: 
Absentee and Mail ballots 
Early Vote cartridges 
Election Day cartridges 
Manual Data Entry 

11.3.Using the Tally Wizard 

The Tally Wizard consists of five panes.  They are 1) Tally Type, 2) Results, 3) Source, 4) 
Parameters (only for Pre and Post LAT) and 5) Review. 
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11.3.1. Getting to the Right Window 
Follow the steps below to access the Tally Wizard: 
1. From the menu bar, click Election Day, and then select Tally. 

For a new tally, the Tally Wizard launches to the first Tally Type pane. 
For a re-tally, the Tally Wizard launches to the last pane—Review—as shown below.  
Note: To return to the Tally Type pane, click the <<Begin button on the Review pane. 

!  

11.3.2. Setting the Tally Wizard for Pre-LAT Cartridge Tally 
To tally pre-LAT Edge cartridges you must use the Tally Wizard.  
Note: You must have the current election open. 
1. From the menu bar, click Election Day and then select Tally. 

The Tally Type pane appears. 
Note: If the Review pane is displayed, click the <<Begin button to return to the Tally Type 
pane. 
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!  

2. On the Tally Wizard Tally Type window, select Tally Type.  
3. Click Next.  

The Tally Wizard Results window opens. 
4. On the Tally Wizard Results window, make sure that Pre-LAT Election appears in drop 

down list box. 
5. Click Next.   

The Tally Wizard Source window opens. 

!  

6. Click the Read Cartridge radio button. 
Optionally, click the Backup Cartridges option to have the system copy cartridge files to the 
database.  This option can add to the reading time of each cartridge.   

7. Click Next.  
The Tally Wizard Parameters window opens (This is only incase of Pre and PostLAT). 
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8. Select the Tally Mode from the drop down box. 
9. Click Next. 

The Tally Wizard Review window opens. 

!  

10. Click Finish.  
The Cartridge Processing window appears. 

!  

11.3.3. Tallying Cartridges 
Follow the steps below to tally cartridges. 
1. Insert a cartridge into the cartridge reader or cartridge extender. Make sure that the 

cartridge is solidly seated. 
WinEDS will automatically read the cartridge. The following Cartridge Statuses will 
appear as cartridge is processed: 
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▪ Set Reader Path 

▪ Ready 

▪ Processing 

▪ Remove cartridge 
2. When WinEDS has finished reading the cartridge, remove it. 

The serial number will be added to the list under Processed Cartridges, and 
The time of reading the cartridge will appear next to its serial number. 
Note: It is recommended that you wait a few seconds before removing the cartridge from 
the extender/reader 

11.3.4. Monitoring cartridge processing 
The Cartridge Processing window of the Pre-LAT tally module can be used to view the status of 
cartridge and/or HAAT processing for Pre-LAT, reprocessing of a cartridge, retransmitting of 
the HAAT or the deletion of a particular cartridge for a tally mode.  
It provides real time viewing of the status of a cartridge and HAAT, from any workstation, as it 
is being posted to the system. As cartridges are being read from any workstation, a status record 
is displayed for one of the Show Cartridges status options. 
The Show Cartridges status options provide the user with an up to the minute reporting of 
cartridge processing.  
On the Cartridge Processing window you can: 
• View status of cartridge processing 
• View Status of Tally Sessions 
• View Status of the Tally 
• View Status of the server 
Follow the steps below to monitor cartridge processing 
1. On the Election Day menu on the menu bar, click on Cartridge Processing. 

The Cartridge Processing window appears. 
2. Select the Pre-LAT tally Mode from the drop-down list. 

The tally mode you have selected will appear in the title bar after the words Cartridge 
Processing. 

3. Enter a number in the Refresh Interval (sec) field and click the Set button.  
Once entered, the display will automatically refresh after the specified number of seconds. 
Note: To keep the display from automatically refreshing, do not enter a number in the 
Refresh Interval (sec) field. If a number is already there, you can click on the field and press 
the Delete button on your keyboard. 
Note: To refresh the display at any time, click on the Refresh Now! button. 

4. Click on the Cartridge Processing tab to select it (if necessary). 
5. In the Show Cartridges field, select All to show information for all cartridges (this also 

refers to Insight Packs read). 
As the votes are tallied, you can see the status of each cartridge change as it is processed: 

▪ When a cartridge is first inserted in a cartridge reader, it first appears in the display.  
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Its status is In Queue and its data is in Blue. 

▪ When it is being processed, its status changes to In Process and its data is in Green. 

▪ When it has been successfully processed, its status changes to Done and its data is in 
Black. 

▪ If it has not been successfully processed, its status changes to Review, and the reason 
is displayed (for example, No Tally No Turnout). 

▪ Information totals appear on the bottom line of the display. 
6. Click Close to close the Cartridge Processing window. 

11.3.5. Monitoring HAAT Cartridge Processing 

On election night if cartridges and/or Insights results are being brought in through the HAAT 
via a modem you can start or stop a process in the HAAT Cartridge Processing window.  Some 
jurisdictions will not be physically reading in cartridges as stated in 11.3.3.   
1. Select the Tally Mode the HAAT results should go into (PreLAT, Official, PostLAT). 
2. Select the Tally type the results are going into for the Edge and for the Insight.  For 

Example, if it is Election Day then the Edge results are going into the Election Day Tally 
type and the Insight results are going into the Mail Ballot Tally type. 

3. Select Start Job to begin the process of allowing results to be tallied. 
4. You also have the option to ReMigrate the results which deletes the results that have 

already been tallied and basically reprocesses the information.   
5. Select Close when finished. 

11.3.6. Running Machine Status Report  
Periodically throughout the tally process (specifically on election night) you should run a 
machine status report to get information on which cartridges have and have not been read and 
head off any missing cartridges. 
Follow the steps below to run the Machine Status Report. 
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!  

!  

!

1) Click the printer icon. 
The screen below appears.

2) Click the + next to Election Day.
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!  
 

!  

When you have finished tallying all the cartridges used for pre-LAT, click Close. 

!

3) Double-click Status Report.
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11.4.Importing 400-C Results into WinEDS 

When ready to load 400-C Tally results into WinEDS, do the following: 
1. On the 400-C, Under File, click Save As…. 
2. For the Destination, enter the destination drive followed by the election name, e.g. a:

\mygenl. 
3. Check both Precinct Results and Other Runtime Files check boxes. 
4. Click OK. 
5. Take the floppy disk or usb memory stick to the WinEDS workstation for 400-C Tally.  
6. In WinEDS, run the Tally Wizard, select 400-C Absentee Tally Type, and click Next. 
7. Select Pre-LAT election mode.   
8. Click Next. 
9. In Select Source, select Read Attached Device. Click Next. 
10. Click Finish on review screen.  

The Tally Dominion 400-C window will open (shown below). 

!  

Election Path and Name should be the same as when the 400-C machine files were created. 
Election Path should be the destination drive and the Name should be the one-to-eight 
character filename used for the 400-C, e.g. mygenl. 

11. Click on either Append or Replace depending on the adopted procedure. 

▪ If Procedure A, all Tallies should be done in Append mode (select Append). 

▪ If Procedure B or C, if using only one 400-C the diskette usb memory stick should 
be read in using Replace mode. If reading results in from more than one 400-C 
machine, first disk or usb memory stick should be read in Replace mode and all 
following diskettes or memory sticks must be read in using Append. 

User must be cognizant of the procedures being used and properly coordinate the 
tabulation/backup and the 400-C Tally so as to not inadvertently erase or double up election 
results, taking care in using Append and Replace modes at the appropriate times. 

12. Click Start to read the result off the diskette. 
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12. Tally Troubleshooting

12.1.Introduction 

Following are several situations and procedures for troubleshooting cartridge reading.  The first 
set of procedures addresses situations where a problem or error message is encountered upon 
inserting the results cartridge into the cartridge reader.  The second set of procedures addresses 
tools available within the system to assist with research and resolution of cartridges that are in 
one of the 5 stages of processing other than successful. 

12.2.Cartridge Reading Errors 

12.2.1. Cartridge reader does not respond 
This problem can manifest itself in two different ways. Sometimes the WinEDS tally screen 
will continue to show the “Insert Cartridge” status even when another cartridge is placed in the 
reader. No tallying activity occurs. Other times, the “Remove Cartridge” status will not go 
away, even when the cartridge is removed (and even if a new cartridge is placed in the reader). 

  

To solve this problem, do the following: 
1. Make sure that no cartridges are in the reader/extender.  
2. Unplug the USB cord from the workstation and wait a few seconds.  
3. Replug the cartridge reader and let the Windows operating system recognize its presence.  

This only takes a few seconds as well.  
You can now resume cartridge reading normally. 

!

The cartridge status window.
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12.2.2. Cartridge reading error messages 
The key to solving problems with WinEDS cartridges not reading is to pay attention to the error 
messages that are displayed when the cartridges are inserted. Here are the explanations of some 
common error messages listed below. 

!    

!  

!  

!  
  

!

The cartridge does not belong to the current election. 
This usually means that the wrong election is open. 
Check the election name in the lower right corner. In rare 
cases, this can indicate a problem with the reader 
workstation. Check the election or restart the workstation 
to solve this. It could also mean that the machine is not 
assigned to the Precinct or location in the election.

Tally types define how the data enters 
WinEDS. There are different tally types for 
Polling Place, Early Vote and sometimes 
Provisional. Restart the Tally Wizard and 
insure that the cartridge belongs to the 
correct tally type.

This indicates that the Edge machine never had 
its polls opened in Official Election mode. This 
Edge was probably set aside by the person in 
charge of that precinct or location. WinEDS will 
mark the cartridge read and enter zeros. Check 
the event log or tape for confirmation of this. 
[Note: In Cartridge Processing the status will 
show ‘No turnout No Tally’.

The pollworker either turned the power off on the 
Edge prior to or during closing polls or did not close 
polls on this Edge at all. WinEDS will read in the 
data regardless. [Note: In Cartridge Processing the 
status will show ‘No turnout No Tally’. 
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Note: In some cases if you receive the ‘Cartridge information is not valid for this tally type’ message 
this could also be due to a machine that was substituted in for another machine that might have had 
problems.  When substituting machines it is important to keep a record of machines used in the election 
and assign the machine to the election and correct tally type under machine assignment. 

12.2.3. Potential anomalies in reading a cartridge 
The cartridge status of an Edge cartridge under certain conditions can be listed as Unformatted.  
This can occur if the cartridge is misinterpreted by the reader as unformatted even though it is 
obviously not in that state. In fact, if the operator places another cartridge into the reader, its 
status will generally also list as unformatted.  Follow the steps below to correct. 
1. Remove the cartridge and unplug and replug the cartridge reader/extender.  
2. Put the cartridge back in and check its status again.  
3. If it is still reading as unformatted, perform steps 1 above and reboot the local machine.  
4. Put the cartridge back in.  If the status still lists as Unformatted, Click the Set button and 

browse to set the path of the Reader. 
5. If the status is still shows Unformatted, remove the cartridge and set aside.  
6. Unplug and replug the cartridge reader, and proceed with the next cartridge. 
If any of the situations noted above are encountered through the night, apply the solutions listed 
to resolve the problems.  However, if the cartridge reading begins to fail at the first cartridge 
and continues through several readings, you may have a major anomaly that needs to be 
addressed prior to proceeding with tally. 
The first step in fixing a major anomaly is to reboot not just the local machine, but the entire 
system. Make sure that someone is available who knows the appropriate passwords and reboot 
the server. You will also want to reboot all the involved reading stations. After these are finished 
rebooting, you can begin the process of tally over again and see if the cartridge processing is 
occurring. There have been many cases in which doing this solves a series of cartridge reading 
failures. 

12.3.Cartridge Processing Errors 

This section describes general troubleshooting for cartridge processing issues.  The screens and 
functions described below can be accessed from the Cartridge Processing section of the 
Election Day menu. 
At least one person on election night should be monitoring the Cartridge Processing window. 
This is usually the highest level technical person present at the election due to the fact that this 
window is so critical. A processed status for each cartridge is required to complete the election 
and get 100% of precincts reporting. Sometimes the message is that the cartridge was 
successfully read and processed by WinEDS (Successful). Sometimes the cartridge will have a 

!

This cartridge has already been read for 
this Tally Mode. If the cartridge needs to 
be reread, it must first be deleted from the 
Cartridge Processing window.
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different status that may or may not indicate a problem.  
1. On the Election Day menu on the menu bar, click on Cartridge Processing. 

The Cartridge Processing window appears. 

!  

2. Select the Tally Mode from the drop-down list for which you want to view the status of 
cartridges. 
The tally mode you have selected will appear in the title bar after the words Cartridge 
Processing. 

3. Click on the Cartridge Processing tab to select it (if necessary) 
4. In the Show Cartridges field, select All to show information for all cartridges. 

Remember, as the votes are tallied, you can see the status of each cartridge change as it is 
processed: 

▪ When a cartridge is first inserted in a cartridge reader, it first appears in the display.  
Its status is In Queue and its data is in Blue. 

▪ When it is being processed, its status changes to In Process and its data is in Green. 

▪ When it has been successfully processed, its status changes to Done and its data is in 
Black. 

▪ If it has not been successfully processed, its status changes to Review, its data is in 
Red, and the reason is displayed.   
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12.3.1. Using cartridge processing screen to troubleshoot 
If a cartridge reads and under status it displays error during the election, you can check the 
status by double clicking the affected cartridge in Cartridge Processing to view the overview of 
the information sent to the WinEDS database.  

  

Notice the categories of numbers such as Turnout, Tally, Op Log, etc. The first number of 
turnout displays the cartridge number, the second the precinct that that cartridge is assigned to. 
Notice the last number of the row shows the turnout (or result of an individual candidate in a 
contest if in the Tally section). In this way, one can determine if the cartridge does indeed have 
data on it. If it does not, it may be that the Edge was never turned on or used in that election by 
the pollworker. In some remote cases the Cartridge Data Image could be blank.  If this occurs it 
is best to find the vvpat tape or Seiko tape associated with the machine to check if there are 
indeed results.  Another solution is to make an audit cartridge from the machine to get the data 
needed.  
Another useful function of this screen is the Op Log or Operator Log. One can read the 
Operator Log to see the time that the Polls were opened and closed in both Pre LAT and 
Official mode to determine if the machine was utilized in the election. Notice the polls opened 
and closed (in PreLAT mode above at 10:09:47 AM on 3/4/02 above.) 
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12.3.2. Using cartridge utilities to troubleshoot 
1. On the Tools menu on the menu bar, click Cartridge Utilities, and then select the machine. 

The Cartridge Utilities window appears. 
2. Insert a cartridge into the cartridge reader. Make sure that the path is pointing to the 

correct drive. 
3. When the icon displays a status of Ready, click Menu. 

The drop down menu appears. 

!  

        

4. Select Diagnostics from the menu.   
5. The AVC Edge Cartridge Diagnostics window opens. 

!  

The system checks and displays Cartridge Information. 
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!  

The system checks and displays Polls Status Summary. 

!  

The system checks and displays Ballot Files CRC are OK. 
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!  

The system checks and displays Data Files Crypto Checksum Files are OK. 

!  

The system checks and displays Summary Totals Check. 

If after using the cartridge processing screen and/or the cartridge utilities to diagnose/
troubleshoot the cartridge, you are unable to resolve the problem, for each cartridge that has not 
been successfully processed, follow the directions below for either reprocessing the cartridge or 
deleting its data from WinEDS. 
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12.3.3. Reprocessing a cartridge  
On the Cartridge Processing window for the specific tally mode, follow the steps below to 
reprocess a cartridge: 
Note: Tally must be stopped before reprocessing a cartridge. 
1. Right-click anywhere in the line of data for the cartridge. 

A short-cut menu appears.  
2. Confirm that this is the correct line of data by checking the other information shown for 

it, such as Read Date/Time. 
3. Select Reprocess for all cartridges that are being reprocessed.. 

All the data from the selected cartridge will be reprocessed. 
.And the cartridge will go into 'In Queue' Status in Blue 

4. Start Tally for the cartridges to be reread. 
The line of data will indicate the sequence of processing stages 
5. If the reprocessing has been successful, you are done. If the reprocessing has not been 

successful, delete the cartridge’s data from WinEDS. 
6. Repeat steps 1 through 4 for each cartridge you want to reprocess. 

12.3.4. Deleting the cartridge data from WinEDS 
There are several reasons that it may become necessary to delete a cartridge from the Cartridge 
Processing menu. These include a cartridge being misread and stuck in a status other than 
“Reading” for a significant period of time, a cartridge that incorrectly reads “No Tally” or “No 
Turnout” (when verified against a tape), or a cartridge cannot be cleared up with the 
“Reprocess” action.  
When it becomes necessary to delete a cartridge, do the following: 
WARNING:  Deleting is not reversible. 
1. From the Election Day menu, click Stop Tally.  
2. Verify that Tally has stopped—the Election name in the lower right side of the 

workstation should switch from green to a grey background.  
3. From the Election Day menu, click Cartridge Processing. 
4. Right-click on the cartridge to be deleted. 

A short-cut menu appears.  
5. Confirm that this is the correct cartridge, by checking the other information shown for it, 

such as Read Date/Time. 
6. Select Delete. 

A Delete Confirm window appears. 
7. Click OK. 

The entire data set from the selected cartridge, including the image of the data, will be 
deleted. 
Note:  After you delete a cartridge’s data set, manually enter data from the corresponding 
voting machine report or try to reread the cartridge; this will require you to restart tally.  It 
is always best to reprocess or delete cartridges at the end of the night once all cartridges 
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and data are in. 

12.3.5. Missing Cartridges/Tapes 
It is common for pollworkers unfamiliar with the process of the DRE election to leave certain 
vital components of their materials behind. The most common is forgetting to bring back all 
cartridges from all machines assigned to that polling location. Although strongly stressed and 
addressed in pollworker training, it is not uncommon for this to happen. This needs to be caught 
in the initial check-in process between the ROV and the pollworkers dropping off materials.  
Missing tapes are not as bad as they can be regenerated from the AVC Edge cartridges. If the 
cartridges are missing, the pollworkers must be sent back to gather those cartridges. Entering 
cartridges from tapes is a time consuming process and is only used as a last option approach. 

12.3.6. Manually entering cartridge data 
To manually enter cartridge data, using the machine report from the cartridge's voting machine, 
do the following: 
1. Go to the Tally Processing window. You must also have the current election open. 
2. From the menu bar, click Election Day and then select Tally. 

The Tally Type pane appears. 
Note: If the Review pane is displayed, click the <<Begin button to return to the Tally Type 
pane. 

!  

3. Select Tally Type.  
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4. Click Next.  
The Tally Wizard Results window opens. 

5. Select Official Election from the drop down list box. 
6. Click Next.   

The Tally Wizard Source window opens. 

!  

7. Click the Manual Data Entry radio button. 

8. Click Next.  
The Tally Wizard Review window opens. 

9. Click Finish.  
The Machine Data Entry window appears. 

!  

10. Enter the data from the Machine Report printouts from the voting machines whose 
cartridges have failed.  

11. For each such voting machine (cartridge), do the following: 
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a) Click or just highlight the machine number of the cartridge on the left pane of 
window that you are entering the manual data.   

b) In the pane on the right, type in all the data from the printout from the voting 
machine. It is important to enter the turnout information. 

A summary of the turnout (by selection code) and of the tally (by candidate) will 
appear in the respective fields on the right. 

12. When you have finished entering the data from all the voting machines (whose cartridges 
have failed), for this tally type, click Apply. 
The check box for that machine will automatically be checked as soon as the apply button is clicked. 

13. Click Close to exit the Machine Data Entry window. 
Note: For X of Y issues, refer to Appendix A: X of Y Issues.  
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13. Printing Reports

13.1.Summary Report 

Once you have completed all tally, you will need to print off a copy of the Summary report and 
check that all of the Precinct percentages are 100% and there are no unread cartridges. 

13.1.1. Getting to the Right Window 
You work with reports on the Reports window. 

!  

You can get here from the: 
• Task List, by double-clicking on Reports, 
• Menu Bar, by clicking on the Election menu, and then clicking on Reporting, 
• Tool Bar, by clicking on the Display report window icon.  

13.1.2. Printing Summary Report 
1. Open the election for which you want to run reports. 
2. Click on Election Day. 
3. Select 3-column summary report. 
4. Print the report. 
5. Close the report by clicking on the File menu and then clicking Close. 

The Reports window reappears. You can run other reports. 
6. When you are done running reports for this election, click Close to close the Reports 
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window. 

13.2.HTML Summary Report 

You can export WinEDS data as a HTML Summary on the HTML Export Utility window. 
WinEDS enables you to display information about your jurisdiction's contest results and turnout 
on a web page.  People who view the web page will be able to see turnout and summary 
information.  Using HTML links, they can "drill down" in the report to see the results of each 
contest. 
To display contest results on your web page, do the following: 
1. Select Export from the Reports window. 

Select HTML Summary. 
The HTML Export Utility window appears. 

!  

2. Select Include Write In if you want to include data for Write In candidates. 
3. Select Tally Mode if you want either Pre LAT or Post LAT. In candidates. 
4. Select Sort Candidates by Votes if you want to order candidates by descending vote total. 
5. Enter the location of your jurisdiction's logo (optional), either: 

▪ the logo's URL, if you are exporting HTML to be published, or 

▪ the path for the logo file. 
6. Select the Restore Default button for all panes in the Export Utility (there are 3). 
7. Click the Export button. 

The Select File window appears. 
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!  

8. Scroll in the Select File window, browse to the path where you would like to export/save 
the files. 

9. Select the file you want to export and click Save. 
When the exporting is complete, your web browser will automatically open, displaying the 
data as a visitor to your jurisdiction's web page would see it. 
The name of each contest is a link.  Clicking on a contest name will take you farther down 
the web page, where you can see candidate names and the votes received by each. 

13.3.State Report 

13.3.1. Entering Alternate/State Codes into WinEDS 

13.3.1.1. Introduction 

External Codes provide a link from WinEDS data elements to external systems such as other 
tabulation systems and state reporting systems.  WinEDS allows the user to define two types of 
external codes: 
• Alternate Codes 
• State Codes
The alternate code is used to link to external tabulation systems and the state code is used to 
link data to state reporting systems. WinEDS provides an alternate code and state code for: 
• Each precinct 
• Each Contest / Proposal
• Each Candidate / Response Set
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13.3.1.2. Getting to the Right Window 

You can enter external codes for Contest/Candidate on the External Codes window of the 
Election Setup module. 

!  

 External Codes window of the Election Setup module 

You can get here from the Menu Bar, by clicking the Election Setup menu, and then clicking on 
External Codes. 

13.3.1.3. Entering state codes for contests 

To maintain external codes for a contest: 
1. Click on the Contest tab of the External Codes window. 
2. Locate the contest and click in the Alternate Code or State Code cell. 

Enter or change the information in the cell of the Contest. 
Note: Typically, the value of the alternate codes will be dictated by the external tabulation 
system and the State election office will provide the state codes. 

3. Click Apply to save your entries to the database. You can use the arrow keys or the tab 
and alt tab keys to navigate the spreadsheet.   
Note: It is not necessary to apply the changes after each edit.  You may save all the changes 
when you have completed the Contest External Code maintenance. 
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13.3.1.4. Entering state codes for candidates 

To maintain external codes for a candidate: 
1. Click on the Candidate tab of the External Codes window. 

 !  

2. Locate the candidate and click in the Alternate Code or State Code cell. 
3. Enter or change the information in the cell of the Candidate. 

Note: Typically, the value of the alternate codes will be dictated by the external tabulation 
system and the State election office will provide the state codes. 

4. Click Apply to save your entries to the database.  You can use the arrow keys or the tab 
and alt tab keys to navigate the spreadsheet.   
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Intentionally left blank. 
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14. Backing Up & Restoring Databases with 
Microsoft SQL 2000

14.1.Introduction 

One of the basic functions in dealing with databases is the backup and restore database 
function. These are actions that will be used commonly, so it is wise to discuss the proper way 
to perform these functions. Included here is a discussion of the proper way to perform this task 
within the Microsoft SQL 2000 Enterprise Manager program. 

14.2.Backing Up Election and Profile Databases 

Follow the steps below to back up a database: 
1. In SQL Enterprise Manager, go to the Tools menu, and select Backup Database ….  

This will bring up the SQL Server Backup - <Database> window as shown below.  

!  

As shown in above, the last used backup device is shown below in the Destination window. 
2. Select the name of the database to be backed up in the top drag-down box. You can also 

add a name for this backup and a description to aid you when selecting from multiple 
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backups at a later date. 
3. Select the type of backup to perform from the Backup section.  

▪ Choose Database – complete if you want to create your first backup or a backup 
that will be used by itself to regenerate an election or will be sent to another server 
for restoration.  

▪ Choose Database – incremental if you want to create a backup set to backup your 
work over a period of time (weeks or day).  

▪ The Transaction Log backup option is usually used for large, wide-access databases 
or for backup up logs in a large transaction such as vote tally. 

The last destination device or file used to backup this device should still be highlighted in 
the Destination box.  

4. You may choose another destination or a series of spanned backup files by selecting the 
Add button.  
This brings up the Select Backup Destination dialog box. 

!  

Backup devices must be initialized the “Management” section of Enterprise Manager to 
appear in Backup Device section as shown above. 

5. Select the files or existing Backup device for your destination and press the OK button. 
6. From the Overwrite section of the SQL Server Backup - <Database>, one can select 

whether the Backup device or file will be appended to (use if adding an election to a 
profile backup) or overwritten (to create a smaller backup file with only a few backups 
within).  

7. Use the Schedule radio button to maintain a backup schedule to a particular backup 
device, if necessary. 

8. Most backups will require none of the options from the Options tab. Press the OK button 
to make your backup.  
The following message appears upon successful completion of the backup. 
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!  

14.3.Creating a New Backup Device 

Backup devices allow an easy way to manage the various backup files that are generated when 
backups databases in SQL 2000. They also provide a method for backing up databases straight 
to tape backups. To create a new backup device, do the following: 
1. Expand the Management folder of SQL Enterprise Manager and select the Backup object.  

A list of initialized backup devices will appear on the right-hand side.  
2. Right click in this area (or right click on the Backup object) and select New Backup 

Device …. 
The Backup Device Properties window appears. 

!  

3. Specify a name for the new backup device and a backup device location. 
4. Verify the location to create the backup device and press the OK button. 
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14.4.Connecting to a Backup Device 

Backup files can be located on removable media or on the server hard drive. If you desire to 
add a backup files as a backup device, then follow these steps: 

1. Copy the backup file to the hard drive of the server into the %root%/Program Files/
Microsoft SQL Server/Backup or %root%/Program Files/Microsoft SQL 
Server/%Named Instance%/Backup folder.  

2. Expand the Management folder of SQL Enterprise Manager and select the Backup 
object.  
A list of initialized backup devices will appear on the right-hand side.  

3. Right click in this area (or right click on the Backup object) and select New Backup 
Device …. 

4. Give the backup device the same name and path as your file.  
You can now view the contents of your backup device and manage the contents within. 

14.5.Restoring Election and Profile Databases 

14.5.1. Restoring to existing election database 
One can restore over an entire database, or make gradual and sequential restores depending on 
the type of database backup that was created. WinEDS databases and database backup generally 
consist of and require a Profile and an Election database. These are usually backed up together 
as a set. To restore and entire database, do the following: 
1. Go to the Tools menu in SQL Enterprise Manager, and select Restore Database ….  

This will bring up the Restore database window as shown below. 
Note: If this database does not exist, then you will need to use the WinEDS Database Setup 
utility to create either a new Profile database, or connect to a Profile and use the WinEDS 
application to create a new election database. 
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!  

Note: There are three options to pick from as the source of our restoration. 
5. Select the Restore option From device.  

The window layout will change to resemble that shown below. 

!  

6. Use the Select Devices button to choose the file or backup device to restore from.  
This will bring up the Choose Restore Devices window shown below. 

!

This is the most common restore option.
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!  

7. Press the Add … button to bring up the Choose Restore Destination window (not 
shown).  
Here one can select to restore from a file or from a backup device.  

8. Select the appropriate device or file location and press the OK button. 
The selected restore source will now appear in the Choose Restore Devices window.  

9. Press the OK button to return to the Restore Database window.  
Note: The selected file or device appears there as well (not shown). 

10. Select the Options tab of the Restore Database window.  
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11. Check the Force restore over existing database option to copy over the information 
contained in the old database.  

  

12. Finally, insure that the physical file name destination of the restore is correct with the 
path and filename shown in the Move to physical file name column. Any corrections 
should be typed in here or copied in from File Explorer or another source. The Logical 
file name column can be ignored for our purposes; it represents the original name given 
to the database before it was backed up. 

13. Press the OK button to proceed with the restoration.  
14. Read error messages carefully to determine the cause of any errors during this process. 

They can usually be caused by incorrect paths in the database destination in the Options 
tab. 

When the Profile database is restored, one can restore the associated Election database to 
complete the restoration. Use the same process as shown in steps 1 thru 14 above to accomplish 
this. 
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14.5.2. Name Changes 
If there was a name change between our backup database names and our new database names, 
we will need to let WinEDS know this. Example: when WinEDS goes to open the Election 
database called “MUNI_CREOLE_2003” and finds the Election database 
“CRE_MUNICIPAL_2003”, it would error out as shown below.  

!  

The message displayed above appears if the name of the Election has changed. 
If the name of your profile database has been changed, you will get the error message shown 
below. 

!  

To correct, perform the following steps: 
1. Go to the Tools menu in SQL Enterprise Manager, and select SQL Query Analyzer.  

This will bring up the Restore database window as shown below. 

!  

2. Type in util_ConfigElection {MY_PROFILE}, {MY_ELECTION} in top the query 
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window.  
Note: Replace the designations in {} with the names of your Profile and Election 
databases.  

3. Insure that the active database that this script will be run against is changed from master 
(default) to the name of your Election database. Select the election to be adjusted from 
the drag down menu by the green arrow at the top of the screen. Alternatively, press 
[Cntl]-U to see a list of all databases on the SQL server.  

4. Click on the green arrow (run) button.  
The results window should show The command(s) completed successfully. 

14.5.3. Restoring to new election database 
Perform this series of tasks when you need to restore an election onto a server where no election 
database has been previously setup (by WinEDS). 
1. If it does not exist, create the Profile database using the WinEDS Database Setup 

program. Otherwise, you may use an existing Profile. 
2. Restore the Profile from the backup into the created Profile database. 
3. Create the election you want to restore into using  WinEDS. 

a) Open WinEDS and select New Election from the File menu. 
b) Use the following information to create the election: 

• Election type: General 

• Election name: {SAME AS YOUR ELECTION} (if desired, or you can 
change this) 

• Election date: Any date in the future 
• Leave everything else as is on this first screen. 

c) The Path screen should be left as is unless changes are required. 
d) On the Parameters screen, uncheck all options if they exist. 
e) Leave the next screens as is and go to Finish. 

4. Restore the Election from the backup into the created Election database using MS SQL. 
5. Restore the Profile from the backup over the previously used Profile.  

This step insures that no additional Election databases are added to the Profile (ie. the one 
you just created!) and that no Elections have duplicate entries in the Profile. 

6. Run the util_ConfigElection script, if needed (see the previous section). 
7. Backup the new Profile and Election databases to avoid repeating the above steps. 
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15. SQL Basics

Follow the steps below to run an SQL Query. 
1. From the Start button, click Programs, Microsoft SQL Server, and Query Analyzer. 

!  

The Connect to SQL Server window appears. 

!  
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2. Type in the password. 
The SQL Query Analyzer appears. 

!  

3. From the drop down list, choose the database name. 
4. From the menu bar, click File, and click Open. 

The Open Query File window appears. 

!  
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5. Choose the appropriate query file, and click Open. 
The query opens. 

!  

6. Click the green arrow to execute the query. 
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16. WinEDS System Security

16.1.Introduction 

Many times one tends to sign in as SA on a day to day basis. This can lead to problems for the 
best of us. For instance, one could inadvertently stop tally during election night. If you sign on 
as a user other than SA, and SA authority is required; WinEDS will typically prompt you for 
that password. By creating roles (or using the default roles provided by WinEDS), you can 
properly administer the various election creation and operation tasks used day to day. 

16.2.System Administrator Role 

• Changing role properties for SA 
• Start Tally 
• Stop Tally 
• Reset Data Store 
• Refresh Precinct Data 

16.3.Assigning Roles and Users 

Define a role that has complete Administrator rights to perform all tasks and assign the 
WinEDS administrator user to this role. Although this user will still have to enter the SA 
password to perform the above listed tasks, this is still a good check and safeguard. 
One may desire to have separate roles such as Create Cartridge or Registration that will only be 
able to perform specific duties. Users can be assigned to those roles to perform these daily 
upkeep tasks. 
It is always a good idea to have a role for Tally only and have several users that are assigned for 
this role. This will keep random or mistaken mouse clicks from stopping tally or pull reports at 
inappropriate times. 
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Appendix A  
Quick Reference - WinEDS Pre-LAT and 
Tally Procedures

Use the following list to ensure all pre-election LAT items have been checked and completed in 
WinEDS.  An asterisk (*) indicates additional notes for tallying on election day, specifically. 

PHASE I: WINEDS PRE-LAT SETUP

YES NO

Assign voting machines to the precincts or locations in each applicable tally type

Enter voter registration using either simple or standard registration method

PHASE II: CREATE RESULTS CARTRIDGES

YES NO

Check and/or set machine settings/parameters 

Run cartridge labels for results cartridges

Label results cartridge

Create results cartridges

PHASE III: CREATING SUPPLEMENTARY CARTRIDGES IN  WINEDS
YES NO

Create card activator (auto activate) files or HAAT files. 

Program card activators (for Pre-LAT process and, if desired, for election day) 
Ensure Date and Time are correct.

Write vote simulation script in WinEDS

Create vote simulation cartridges
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PHASE IV: 400-C MACHINE PRE-LAT SETUP

YES NO

Generate 400-C machine election files in WinEDS

Load 400-C machine election files onto 400-C 

Ensure 400-C test deck script has been established and test deck (including header 
cards, if to be used) have been marked.

PHASE V: CONDUCT PRE-LAT ON EDGES (FOR ADDITIONAL DETAILS, 
CONSULT EDGE LOGIC AND ACCURACY GUIDE)
YES NO

Physically set up the Edges

Check external parts

Ensure machine is fully charged

Perform firmware update (if necessary)

Check the date and time for correctness 

Check screen calibration

Insert results cartridge to load election

Open polls in pre-LAT and verify pre-LAT Zero Proof Report Tape

Run vote simulation  cartridge

Perform any manual votes desired

Close polls in pre-LAT and verify the accuracy of the vote simulation pattern on the 
pre-LAT Results Report Tape (and any additional manual votes cast)

Create audit trail cartridge (if desired)

PHASE VI:  PRE-LAT 400-C MACHINE

YES NO

Run test deck through 400-C

Save results from 400-C
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PHASE VII:  CONDUCTING TALLY

YES NO

Backup Database

Start tally in WinEDS

Run and print Summary Report to show zero totals

Set tally wizard 

Note:  The Phase VII steps below follow a general sequence for conducting tally during pre-LAT 
(tallying cartridges first and then importing 400-C results).  *However, for election day, please be 
sure to follow the sequence appropriate for your county (for example, you may need to import 
400-C results first and then tally cartridges after).

Tally cartridges, being sure to monitor cartridge processing throughout the process

*On election night, periodically run Machine Status Report throughout the evening

*On election night periodically run Summary Report throughout the evening as 
desired.

*On election night periodically run HTML Summary Report throughout the evening 
as desired

Import 400-C results into WinEDS

*On election day, when last cartridge has been tallied, print a final Machine Status 
Report to verify that all cartridges have indeed been processed.  If any is showing as 
not having been processed, determine whether the cartridge is missing or did not 
process correctly.  If it is not missing, reprocess the cartridge.  If it is missing, 
manually enter results from machine results tape, if available.

Check cartridge processing screen to ensure all cartridges are listed as “Success.”  If 
any cartridge is listed in a status other than “Success,” follow troubleshooting 
methods described in Chapter 12 to resolve.

PHASE VIII:  REPORTING

YES NO

Run final Summary Report 

*On election day, check precincts reporting on final Summary Report.  If the 
percentage does not equal 100%, try to determine why (for example, because of 
missing cartridges, cartridges that won’t read, cartridges stuck in a status other than 
“Success”).  After researching, set precincts processed to 100% if necessary and 
desired and rerun Summary Report to show 100%.

*On election day, run final HTML Summary Report

Stop tally
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Appendix A: 

1. Set Precincts Processed to 100% 

If all cartridges are processed and you have completed tally, but your machines processed are not 
100% for X of Y, do the following: 

1. Stop tally. Refer to Section Error! Reference source not found. on page Error! 
Bookmark not defined.. 

7. Backup the Election and Profile databases. Refer to Section Error! Reference source 
not found. Error! Reference source not found. on page Error! Bookmark not 
defined.. 

8. Run a Machines Processed Report to ensure all cartridges and MemoryPacks have been 
read and successfully tallied. If cartridges / Memorypacks were successfully read, go to 
the next step. 

*On election day or post-election day, run State Export Report (ensure alternate/state 
codes have been previously entered into WinEDS)

PHASE IX:  BACK UP DATABASES

YES NO

Back up election and profile databases
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9. From the WinEDS menu bar, click Election Day > Refresh Data Store. 
The Refresh Data Store window is displayed. 

!  

10. Click the Set 100% button to the right of Processed Status to make everything 100%. 

!281



282


	Cover Sheet
	Report and Conclusions
	Early Voting Machine Reports
	Notice of November 12 Commissioner Mtg
	Meeting Minutes
	DA Investigation Report
	Secretary of State Memo
	WinEDS Logs
	Dominion Log Explanation
	Dominion Voting Systems Manual



